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Regulatory Compliance 
The ADSP-CM403F EZ-KIT Lite is designed to be used solely in a labo-
ratory environment. The board is not intended for use as a consumer end 
product or as a portion of a consumer end product. The board is an open 
system design which does not include a shielded enclosure and therefore 
may cause interference to other electrical devices in close proximity. This 
board should not be used in or near any medical equipment or RF devices.

The ADSP-CM403F EZ-KIT Lite is in the process of being certified to 
comply with the essential requirements of the European EMC directive 
2004/108/EC and therefore carries the “CE” mark.

The EZ-KIT Lite evaluation system contains ESD (electrostatic discharge) 
sensitive devices. Electrostatic charges readily accumulate on the human 
body and equipment and can discharge without detection. Permanent dam-
age may occur on devices subjected to high-energy discharges. Proper ESD 
precautions are recommended to avoid performance degradation or loss of 
functionality. Store unused EZ-KIT Lite boards in the protective shipping 
package.





ADSP-CM403F EZ-KIT Lite Evaluation System Manual v 

CONTENTS

PREFACE

Product Overview ............................................................................  x

Purpose of This Manual ................................................................  xiii

Intended Audience ......................................................................... xiv

Manual Contents ............................................................................ xv

What’s New in This Manual ............................................................ xv

Technical Support .......................................................................... xvi

Supported Processors ...................................................................... xvi

Supported Tools ............................................................................ xvii

Product Information ..................................................................... xvii

Analog Devices Web Site ......................................................... xvii

EngineerZone ......................................................................... xviii

Notation Conventions .................................................................. xviii



Contents

vi ADSP-CM403F EZ-KIT Lite Evaluation System Manual

USING ADSP-CM403F EZ-KIT LITE

Package Contents .........................................................................  1-2

ADSP-CM403F EZ-Board ............................................................  1-3

Default Configuration ..................................................................  1-3

IAR Embedded WorkBench and Board Installation .......................  1-5

IAR Embedded WorkBench Session Startup ..................................  1-6

SPI Flash ......................................................................................  1-8

Analog Interface ...........................................................................  1-8

UART0 Interface (RS-232) ...........................................................  1-9

CAN0 Interface ..........................................................................  1-10

Debug Interface ..........................................................................  1-10

Serial Liquid Crystal Display Module Interface ............................  1-10

Power-On-Self Test .....................................................................  1-11

Expansion Interface ....................................................................  1-11

Power Architecture .....................................................................  1-12

Power Measurements ..................................................................  1-12

Example Programs ......................................................................  1-13

Reference Design Information .....................................................  1-13



ADSP-CM403F EZ-KIT Lite Evaluation System Manual vii

Contents

ADSP-CM403F EZ-KIT LITE HARDWARE REFERENCE

System Architecture ......................................................................  2-2

Software-Controlled Switches (SoftConfig) ....................................  2-3

Overview of SoftConfig ...........................................................  2-3

 SoftConfig on the ADSP-CM403F EZ-KIT LITE ...................  2-7

Programming SoftConfig Switches ...........................................  2-8

Push Buttons and Switches ..........................................................  2-12

Boot Mode Select Switch (SW1) ............................................  2-13

Reset Push Button (SW2) ......................................................  2-13

GPIO Push Buttons (SW3-4) ................................................  2-13

Jumpers ......................................................................................  2-14

VREF0 External Source Jumper (JP1) ....................................  2-15

VREF1 External Source Jumper (JP2) ....................................  2-15

Buffer Input Select Jumper (JP3) ...........................................  2-15

Power Select Jumper (JP4) .....................................................  2-16

Power Jumpers (P4–6) ...........................................................  2-16

LEDs ..........................................................................................  2-17

GPIO LEDs (LED1–3) .........................................................  2-18

Reset LED (LED4) ................................................................  2-18

Power LED (LED5) ...............................................................  2-18

SYS_FAULT LED (LED6) .....................................................  2-18



Contents

viii ADSP-CM403F EZ-KIT Lite Evaluation System Manual

Connectors .................................................................................  2-19

DCE UART Connector (J1) ..................................................  2-20

Asynch or Memory Connector (J2) ........................................  2-20

Character Display Connector (J3) .........................................  2-20

PWM Connector (J7) ...........................................................  2-21

CAN0 Connector (J8) ...........................................................  2-21

Analog Connector (J9) ..........................................................  2-21

JTAG/SWD/SWV Connector (P1) ........................................  2-21

TRACE and JTAG/SWD/SWV Connector (P2) ....................  2-22

VREF Buffered Connector (P3) .............................................  2-22

Power Connector (P7) ...........................................................  2-22

ADSP-CM403F EZ-KIT LITE BILL OF MATERIALS

ADSP-CM403F EZ-KIT LITE SCHEMATIC

INDEX



ADSP-CM403F EZ-KIT Lite Evaluation System Manual ix 

PREFACE

Thank you for purchasing the ADSP-CM403F EZ-KIT Lite®, Analog 
Devices, Inc. low-cost evaluation system for the ADSP-CM403F 
mixed-signal control processor.

The ADSP-CM403F processor is based on the ARM® Cortex®-M4 pro-
cessor core and is designed for photovoltaic applications. The EZ-KIT 
Lite is shipped with all of the necessary hardware—you can start the eval-
uation immediately. The package contains the standalone evaluation 
board and CE-approved power supply. The EZ-KIT Lite version ships 
with the J-Link Lite ARM, while the EZ-Board® version requires the cus-
tomer to provide a debugger.

Two expansion connectors (analog interface and PWM/digital interface) 
are provided for connecting boards that incorporate motors. Another 
expansion connector is provided for connecting an Anybus board and/or a 
memory/FPGA extender card.

Traditional mechanical switches for changing the board’s factory setup 
have been removed in favor of I2C controlled software switches. The only 
remaining mechanical switches are the boot mode switch and push 
buttons.
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The evaluation board is designed to be used in conjunction with the IAR 
Embedded Workbench development tools to test capabilities of the 
ADSP-CM403F processors. The development environment aids advanced 
application code development and debug, such as:

• Create, compile, assemble, and link application programs written 
in C++, C, and assembly

• Load, run, step, halt, and set breakpoints in application programs

• Read and write data and program memory

• Read and write core and peripheral registers

Product Overview
The board features:

• Analog Devices ADSP-CM403F processor

• 120-pin LQFP package

• 30 MHz CLKIN core oscillator

• Universal Asynchronous Receiver/Transmitter (UART0)

• Analog Devices ADM3252E RS-232 line transceiver

• DB9 female connector

• Controller Area Network (CAN) interface

• Analog Devices ADM3053 transceiver

• RJ11 connector
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• Display

• New Haven NHD-0220D3Z-FL-GBW

• 2  20 character

• 2-wire interface (TWI) control

• RESET controller

• Analog Devices ADM708 microprocessor supervisory 
circuits

• Debug (JTAG/SWD/SWV/TRACE) interface

• JTAG/SWD 20-pin 0.1” header for use with IAR emulators

• Trace/JTAG/SWD/SWV 20-pin 0.05” header

• LEDs

• Six LEDs: one power (green), one board reset (red), one 
SYS_FAULT (red), and three general-purpose (amber)

• Push buttons

• Three push buttons: one reset, two IRQ/Flag

• Asynchronous connector

• 180-pin Samtec (QSH-090-01-F-D-A) 0.5 mm spacing

• SMC0 address, data, and control

• CLKOUT

• SPI0

• UART2

• TWI0

• GPIOs
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• RESET

• GND/3.3V/5V output

• Pulse-width modulation (PWM) connector

• 180-pin Samtec (QSH-090-01-F-D-A) 0.5 mm spacing

• PWM0–PWM2

• SINC0

• SPI0

• TWI0

• TM0

• CNT0–CNT1

• SPORT1

• GPIO

• RESET

• GND/3.3V/5V output

• 5V input

• Analog connector interface

• 120-pin Samtec (QSH-060-01-F-D-A) 0.5 mm spacing

• ADC0–ADC1

• DAC0–1

• AGND/GND/VREF/5V output

• ADR441 voltage reference (VREF)

• ADA4899 buffer—0.1” header for reference
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• External power supply 

• CE compliant

• 5V @ 3.6 Amps

• Ability to power from the PWM connector

• Other features

• 0.05-ohm resistors for processor current measurement

For information about the hardware components of the EZ-KIT Lite, 
refer to ADSP-CM403F EZ-KIT Lite Bill Of Materials. 

Purpose of This Manual
The ADSP-CM403F EZ-KIT Lite Evaluation System Manual provides 
instructions for installing the product hardware (board). The text 
describes operation and configuration of the board components and pro-
vides guidelines for running your own code on the ADSP-CM403F 
EZ-KIT Lite. Finally, a schematic and a bill of materials are provided for 
reference.
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Intended Audience
The primary audience for this manual is a programmer who is familiar 
with an ARM Cortex-M4-based core. 

The ADSP-CM40x family of mixed-signal control processors is based on 
the ARM Cortex-M4 processor core with floating-point unit and inte-
grated SRAM memory, flash memory, accelerators, and peripherals.

The applicable documentation for programming the ARM Cortex-M4 
processor core includes:

• Cortex-M4 Devices Generic User Guide

• CoreSight ETM-M4 Technical Reference Manual

• Cortex-M4 Technical Reference Manual

For additional information on this Analog Devices processor, see the 
ADSP-CM40x Mixed-Signal Control Processor Hardware Reference. This 
document describes the ARM Cortex-M4 processor core and memory 
architecture used on the ADSP-CM40x processor, but does not provide 
detailed programming information for the ARM core. 

For more information about programming the ARM core, visit the ARM 
Information Center:

http://infocenter.arm.com/help/

http://infocenter.arm.com/help/
http://infocenter.arm.com/help/
http://infocenter.arm.com/help/
http://infocenter.arm.com/help/ 
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Manual Contents
The manual consists of:

• Chapter 1, Using ADSP-CM403F EZ-KIT Lite
Describes EZ-KIT Lite functionality from a programmer’s perspec-
tive and provides a simplified memory map of the processor. 

• Chapter 2, ADSP-CM403F EZ-KIT Lite Hardware Reference
Provides information about the EZ-KIT Lite hardware 
components.

• Appendix A, ADSP-CM403F EZ-KIT Lite Bill Of Materials
Lists the hardware components used to manufacture the EZ-KIT 
Lite.

• Appendix B, ADSP-CM403F EZ-KIT Lite Schematic
Lists the resources for board-level debugging.

What’s New in This Manual
This is the first edition (Revision 1.0) of the ADSP-CM403F EZ-KIT Lite 
Evaluation System Manual.
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Technical Support
You can reach Analog Devices processors and DSP technical support in 
the following ways:

• Post your questions in the processors and DSP support community 
at EngineerZone®:
http://ez.analog.com/community/dsp

• Submit your questions to technical support directly at:
http://www.analog.com/support

• E-mail your questions about processors and processor applications 
to: 
processor.support@analog.com or
processor.china@analog.com (Greater China support)

• In the USA only, call 1-800-ANALOGD (1-800-262-5643)

• Contact your Analog Devices sales office or authorized distributor. 
Locate one at:
www.analog.com/adi-sales

• Send questions by mail to:
Processors and DSP Technical Support
Analog Devices, Inc.
Three Technology Way
P.O. Box 9106
Norwood, MA 02062-9106
USA

Supported Processors
This evaluation system supports Analog Devices ADSP-CM403F 
processors.

http://ez.analog.com/community/dsp
http://www.analog.com/support
mailto:processor.support@analog.com
mailto:processor.china@analog.com
http://www.analog.com/adi-sales 
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Supported Tools
Information on supported tools for the ADSP-CM403F EZ-KIT Lite and 
the ADSP-CM40x family of mixed-signal control processors is available 
at:

http://www.analog.com/CM403FEZKit

Product Information
Product information can be obtained from the Analog Devices Web site 
and the online help system.

Analog Devices Web Site
The Analog Devices Web site, www.analog.com, provides information 
about a broad range of products—analog integrated circuits, amplifiers, 
converters, and digital signal processors.

To access a complete technical library for each processor family, go to 
http://www.analog.com/processors/technical_library. The manuals 
selection opens a list of current manuals related to the product as well as a 
link to the previous revisions of the manuals. When locating your manual 
title, note a possible errata check mark next to the title that leads to the 
current correction report against the manual. 

Also note, myAnalog.com is a free feature of the Analog Devices Web site 
that allows customization of a Web page to display only the latest 
information about products you are interested in. You can choose to 
receive weekly e-mail notifications containing updates to the Web pages 
that meet your interests, including documentation errata against all manu-
als. myAnalog.com provides access to books, application notes, data sheets, 
code examples, and more.

http://www.analog.com
http://www.analog.com/processors/technical_library/ 
http://www.analog.com/subscriptions 
http://www.analog.com/subscriptions 
http://www.analog.com/CM403FEZKit 
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Visit myAnalog.com (found on the Analog Devices home page) to sign up. 
If you are a registered user, just log on. Your user name is your e-mail 
address.

EngineerZone
EngineerZone is a technical support forum from Analog Devices. It allows 
you direct access to ADI technical support engineers. You can search 
FAQs and technical information to get quick answers to your embedded 
processing and DSP design questions.

Use EngineerZone to connect with other DSP developers who face similar 
design challenges. You can also use this open forum to share knowledge 
and collaborate with the ADI support team and your peers. Visit 
http://ez.analog.com to sign up. 

Notation Conventions
Text conventions used in this manual are identified and described as 
follows. 

Example Description

File > Close Titles in reference sections indicate the location of an item within the 
CCES environment’s menu system (for example, the Close command 
appears on the File menu).

{this | that} Alternative required items in syntax descriptions appear within curly 
brackets and separated by vertical bars; read the example as this or 
that. One or the other is required.

[this | that] Optional items in syntax descriptions appear within brackets and sepa-
rated by vertical bars; read the example as an optional this or that.

[this,…] Optional item lists in syntax descriptions appear within brackets delim-
ited by commas and terminated with an ellipse; read the example as an 
optional comma-separated list of this.

http://www.analog.com/subscriptions 
http://ez.analog.com
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.SECTION Commands, directives, keywords, and feature names are in text with 
letter gothic font.

filename Non-keyword placeholders appear in text with italic style format.

Note: For correct operation, ...
A Note provides supplementary information on a related topic. In the 
online version of this book, the word Note appears instead of this 

symbol.

Caution: Incorrect device operation may result if ...
Caution: Device damage may result if ... 
A Caution identifies conditions or inappropriate usage of the product 
that could lead to undesirable results or product damage. In the online 
version of this book, the word Caution appears instead of this symbol.

Warning: Injury to device users may result if ... 
A Warning identifies conditions or inappropriate usage of the product 
that could lead to conditions that are potentially hazardous for the 
devices users. In the online version of this book, the word Warning 
appears instead of this symbol.

Example Description






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1 USING ADSP-CM403F EZ-KIT 
LITE

This chapter provides information to assist you with development of pro-
grams for the ADSP-CM403F EZ-KIT Lite evaluation system.

The following topics are covered.

• Package Contents

• ADSP-CM403F EZ-Board

• Default Configuration

• IAR Embedded WorkBench and Board Installation

• IAR Embedded WorkBench Session Startup

• SPI Flash

• Analog Interface

• UART0 Interface (RS-232)

• CAN0 Interface

• Debug Interface

• Serial Liquid Crystal Display Module Interface

• Power-On-Self Test

• Expansion Interface

• Power Architecture
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• Power Measurements

• Example Programs

• Reference Design Information

For detailed information on how to program the ADSP-CM403F proces-
sor, refer to the documents listed in the Preface.

Package Contents
Your ADSP-CM403F EZ-KIT Lite package contains the following items:

• ADSP-CM403F EZ-KIT Lite board

• Universal 5V DC power

• J-Link Lite ARM (only in the EZ-KIT Lite version)

Contact the vendor where you purchased your EZ-KIT Lite or contact 
Analog Devices, Inc. if any item is missing.
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ADSP-CM403F EZ-Board
The ADSP-CM403F EZ-KIT Lite is shipped with the J-Link Lite ARM 
debugger. When the product is not shipped with the debugger, it is 
referred to as the ADSP-CM403F EZ-Board.

 The EZ-Board requires a third party emulator.

Default Configuration
The ADSP-CM403F EZ-KIT Lite board is designed to run outside your 
personal computer as a standalone unit. 

When removing the EZ-KIT Lite board from the package, handle the 
board carefully to avoid the discharge of static electricity, which can dam-
age some components. 

The EZ-KIT Lite evaluation system contains ESD (electrostatic discharge) 
sensitive devices. Electrostatic charges readily accumulate on the human body 
and equipment and can discharge without detection. Permanent damage may 
occur on devices subjected to high-energy discharges. Proper ESD precau-
tions are recommended to avoid performance degradation or loss of function-
ality. Store unused EZ-KIT Lite boards in the protective shipping package. 
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Figure 1-1 shows the default jumper and boot mode switch settings used 
in installation. Confirm that your board is in the default configuration 
before using the board.

Figure 1-1. Default EZ-KIT Lite Hardware Setup
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IAR Embedded WorkBench and Board 
Installation

For information about the IAR Embedded WorkBench® product and 
software download, go to:

http://www.iar.com/en/Products/IAR-Embedded-Workbench

The ADSP-CM403F EZ-KIT Lite software, based on the IAR Embedded 
WorkBench, can be found at:

http://www.analog.com/CM403FEZKit

Follow these instructions to ensure correct operation of the product soft-
ware and hardware.

Step 1: Connect the EZ-KIT Lite board to a personal computer (PC) run-
ning IAR Embedded WorkBench using a J-Link/J-Trace emulator.

1. Plug one side of the USB cable into the USB connector of the emu-
lator. Plug the other side into a USB port of the PC running IAR 
Embedded WorkBench.

2. Attach the emulator to the header connector, P1 or P2, on the 
EZ-KIT Lite board.

Step 2: Attach the provided cord and appropriate plug to the 5V power 
adaptor.

1. Plug the jack-end of the power adaptor into the power connector 
P7 (labeled 5V) on the EZ-KIT Lite board.

2. Plug the other side of the power adaptor into a power outlet. The 
power LED (labeled LED5) is lit green when power is applied to the 
board.

http://www.iar.com/en/Products/IAR-Embedded-Workbench
http://www.analog.com/CM403FEZKit 
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IAR Embedded WorkBench Session 
Startup

It is assumed that the IAR Embedded WorkBench software is installed 
and running on your PC.

1. Navigate to the IAR Embedded WorkBench environment via the 
Start menu. 

Note that IAR Embedded WorkBench is not connected to the tar-
get board.

2. Choose File > Open >Workspace to open a workspace for the proj-
ect to download and debug.

3. Choose Project > Options.

The General Options, Target page appears.

4. In Processor variant, ensure Device is AnalogDevices 
ADSP-CM40z-X_Y, where X is the SRAM size in KB and Y is the 
internal flash size in KB of the part on the target board.

On the Analog Devices ADSP-CM403F EZ-KIT Lite, SRAM size 
is 384 KB, and internal flash size is 2048 KB.
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5. Choose Debugger in the Category pane.

The Debugger, Setup options page appears.

a. In Driver, choose J-Link/J-Trace as the emulator to be used 
to debug the target board.

b. Click the Download tab. The Debugger, Download options 
page appears.

c. Ensure Use flash loader(s) is enabled. Note that other 
download settings are optional.

6. Choose Debugger > J-Link/J-Trace in the Category pane.

The emulator Setup options page appears.

a. On the Setup page,

• In Reset, select Connect during reset from the drop-down 
list.

• In JTAG/SWD speed, select Auto.

• (Optional) In Clock setup, change the default values.

b. On the Connection page,

• In Communication, select USB and Device 0.

• In Interface, select JTAG or SWD.

7. Click OK to save the emulator settings.

8. Choose Project > Debug and Download to download the project 
and start debugging.
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SPI Flash
The EZ-KIT Lite ships with an internal 4 MB SPI flash, connected via the 
SPI2 interface, which is used for booting and scratchpad space. Refer to 
the ADSP-CM40x Mixed-Signal Control Processor Hardware Reference for 
more information about the internal SPI flash.

For more information, refer to the SPI flash example in the POST, which 
is included in the ADSP-CM40x Enablement Software.

Analog Interface
The ADSP-CM403F processor provides two 16-bit ADCs with 12 inputs 
each, ADC0 and ADC1. The ADC signals are connected to the Analog expan-
sion connector (J9). There are also two 12-bit DACs available on J9. 
Refer to ADSP-CM403F EZ-KIT Lite Schematic for more information.

Voltage reference for the ADC channels can be supplied internally from 
the processor or externally by ADR441 ICs. U6 is the VREF0 supply exter-
nal source, and U2 is its VREF1 equivalent. To select the external source for 
either supply, place a jumper on JP1 or JP2. Refer to ADSP-CM403F 
EZ-KIT Lite Schematic for more information.

A buffered version of the voltage reference is available on J9 via a unity 
gain buffer ADA4889 (U22). By default, the internal VREF0 source is 
selected as the input to the buffer (JP3 positions 1 and 2). If the external 
voltage reference is desired, change the jumper to JP3 positions 2 and 3.

Voltage references for the analog inputs are configurable; refer to Jumpers 
for more information.
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UART0 Interface (RS-232)
The ADSP-CM403F processor has three built-in universal asynchronous 
transmitters (UARTs). UART0 is connected to a RS-232 line transmitter. 
UART0 has full RS-232 functionality via the Analog Devices ADM3252E 
isolated line driver and receiver (U23).

 The EZ-KIT Lite voltage isolation components are not intended 
for protecting external products. The isolated ICs are used to show-
case Analog Devices product portfolio only. Adequate voltage 
isolation of any external devices/boards is the user responsibility.

Pin PC_02/UART0_TX/TRACE_D03/SPI0_RDY of the processor is connected to 
the ADM3315 device directly and used for UART transmit. 

Pin PC_01/UART0_RX/SMC0_A05/TM0_ACI5 is connected through SoftConfig 
by default and used for UART receive. (This can be changed through 
SoftConfig.) 

By default, the UART0 CTS signal is not connected, and the UART0 RTS sig-
nal is connected to RS-232. Both connections can be changed through 
SoftConfig. 

The SoftConfig switches also allow the loopback of CTS and RTS. The 
UART0 CTS can be added as an input to the reset circuit through SoftCon-
fig. Refer to Software-Controlled Switches (SoftConfig) for more 
information.

For more information, refer to the UART example in the POST, which is 
included in the ADSP-CM40x Enablement Software. Note that the loop-
back of TX and RX data is done through an external connector.
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CAN0 Interface
The Controller Area Network 0 (CAN0) interface of the EZ-KIT Lite is 
connected to the Analog Devices ADM3053 isolated CAN transceiver 
(U26). The transceiver is attached to the CAN0 port of the ADSP-CM403F 
processor via an RJ-11 connector (J8). See CAN0 Connector (J8).

 The EZ-KIT Lite voltage isolation components are not intended 
for protecting external products. The isolated ICs are used to show-
case Analog Devices product portfolio only. Adequate voltage 
isolation of any external devices/boards is the user responsibility.

The CAN0 transmit and receive signals are connected through the Soft-
Config switches and enabled by default. See Software-Controlled Switches 
(SoftConfig). 

For more information, refer to the CAN0 example in the POST, which is 
included in the ADSP-CM40x Enablement Software.

Debug Interface
The EZ-KIT Lite provides a JTAG/SWD/SWV connection via a connec-
tor (P1), which is a 0.1” header. A 4-bit trace connection also includes 
JTAG/SWD/SWV and is available via a connector (P2). See 
JTAG/SWD/SWV Connector (P1) and TRACE and JTAG/SWD/SWV 
Connector (P2) for more information.

Serial Liquid Crystal Display Module 
Interface

Connector J3 mates with the Newhaven Display International 
NHD-0220D3Z-FL-GBW-V3, a 2-line by 20-character display with a 
yellow/green backlight.
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The display is written using the TWI interface. The TWI address of the 
display is 0x50. The maximum clock rate for the display is 100 kHz. The 
display can be removed if the frequency limitation poses a problem. 

For more information, refer to the serial liquid crystal display example in 
the POST, which is included in the ADSP-CM40x Enablement Software.

Power-On-Self Test
The Power-On-Self-Test Program (POST) tests all EZ-KIT Lite peripher-
als and validates functionality as well as connectivity to the processor. 
Once assembled, each EZ-KIT Lite is fully tested for an extended period 
of time with POST. All EZ-KIT Lite boards are shipped with POST pre-
loaded into flash memory. The POST is executed by resetting the board 
and pressing the proper push button(s). The POST also can be used as a 
reference for a custom software design or hardware troubleshooting.

Note that the source code for the POST program is included in the 
ADSP-CM40x Enablement Software along with the readme.txt file that 
describes how the board is configured to run POST.

Expansion Interface
The expansion interface allows a custom-design daughter board to be 
tested across various hardware platforms that have the same expansion 
interface.

The expansion interface implemented on the ADSP-CM403F EZ-KIT 
Lite consists of three connectors: Asynch or Memory Connector (J2), 
PWM Connector (J7), and Analog Connector (J9). The connectors con-
tain a majority of the processor’s signals. For pinout information, go to 
ADSP-CM403F EZ-KIT Lite Schematic. 
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Limits to current and interface speed must be taken into consideration 
when using the expansion interface. Current for extenders connected to J2 
or J6 can be sourced from the EZ-KIT Lite; therefore, the current should 
be limited to 250 mA for 5V, and 200 mA from the 3.3V planes. If more 
current is required, a separate power connector and a regulator must be 
designed on the daughter card. Additional circuitry implemented on 
extender cards can add extra loading to signals, decreasing their maximum 
effective speed.

 Analog Devices does not support and is not responsible for the 
effects of additional circuitry.

Power Architecture
The ADSP-CM403F EZ-KIT Lite has two primary voltage domains: 3.3V 
and 1.2V. The main input is a 5V wall adaptor. The 5V source can be 
selected via JP4 to input from the PWM connector (J7) as an alternative 
to the wall power adaptor. Refer to PWM Connector (J7) and Power 
Select Jumper (JP4) for details.

The Analog Devices ADP2119 controller provides 3.3V for the VDD_EXT 
signal and the 3.3V power requirements of the board. The VDD_INT signal 
is delivered through either Analog Devices regulator ADP2119 (VR1) or a 
PNP transistor (Q1).

Power Measurements
Locations are provided for measuring the current draw from various power 
planes. Precision 0.05 ohm shunt resistors are available on the 
VDD_EXT, VDD_INT, and 3.3V voltage domains. For current draw, the 
jumper is removed, voltage across the resistor can be measured using an 
oscilloscope, and the value of the resistor can be measured using a preci-
sion multi-meter. Once voltage and resistance are measured, the current 
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can be calculated by dividing the voltage by the resistance. For the highest 
accuracy, a differential probe should be used for measuring the voltage 
across the resistor. For more information, refer to Power Jumpers (P4–6).

Example Programs
Example programs are provided with the ADSP-CM40x Enablement Soft-
ware to demonstrate various capabilities of the product. The programs can 
be found in the CM403F_CM408F_EZ-KIT\examples folder. Refer to a 
readme file provided with each example for more information.

Reference Design Information
A reference design info package is available for download on the Analog 
Devices Web site. The package provides information on the design, lay-
out, fabrication, and assembly of the EZ-KIT Lite.

The information can be found at:

http://www.analog.com/CM403FEZKit

http://www.analog.com/CM403FEZKit 
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2 ADSP-CM403F EZ-KIT LITE 
HARDWARE REFERENCE

This chapter describes the hardware design of the ADSP-CM403F 
EZ-KIT Lite board. 

The following topics are covered.

• System Architecture
Describes the board’s configuration and explains how the board 
components interface with the processor.

• Software-Controlled Switches (SoftConfig)
Lists and describes the processor signals routed through the soft-
ware-controlled switches.

• Push Buttons and Switches
Shows the locations and describes the push buttons and switches.

• Jumpers
Shows the locations and describes the configuration jumpers.

• LEDs
Shows the locations and describes the LEDs.

• Connectors
Shows the locations and provides part numbers for the on-board 
connectors. In addition, the manufacturer and part number infor-
mation is provided for the mating parts.
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System Architecture
This section describes the processor’s configuration on the EZ-KIT Lite 
(Figure 2-1).

This EZ-KIT Lite is designed to demonstrate the ADSP-CM403F proces-
sor’s capabilities. The ADSP-CM403F EZ-KIT Lite has a 30 MHz input 
clock and runs at 240 MHZ internally. 

Figure 2-1. EZ-KIT Lite Block Diagram
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User I/O to the processor is provided in the form of two user push buttons 
and three LEDs. The software-controlled switches (SoftConfig) facilitate 
the switch multi-functionality by disconnecting the push buttons from 
their associated processor pins and reusing the pins elsewhere on the 
board. See ADSP-CM403F EZ-KIT Lite Schematic for more information.

Software-Controlled Switches 
(SoftConfig)

On the ADSP-CM403F EZ-KIT Lite, most of the traditional mechanical 
switches have been replaced by I2C software-controlled switches. The 
remaining mechanical switches are provided for changing the boot mode 
and push buttons. Reference any SoftConfig*.c file found in the installa-
tion directory for an example of how to set up the SoftConfig feature of 
the ADSP-CM403F EZ-KIT Lite through software.

The SoftConfig section of this manual serves as a reference to any user 
that intends to modify an existing software example. If software provided 
from ADI is used, there should be little need to reference this section.

 Care should be taken when changing SoftConfig settings not to 
create a conflict with interfaces. This is especially true when con-
necting extender cards.

Overview of SoftConfig
In order to further clarify the use of electronic single FET switches and 
multi-channel bus switches, an example of each is illustrated and com-
pared to a traditional mechanical switching solution. This is a generic 
example that uses the same FET and bus switch components that are on 
the EZ-KIT Lite. 

After this generic discussion there is a detailed explanation of the Soft-
Config interface specific to the ADSP-CM403F EZ-KIT Lite.
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Figure 2-2 shows two individual FET switches (Pericom PI3A125CEX) 
with reference designators UA and UB. Net names ENABLE_A and ENABLE_
B control UA and UB. The default FET switch enable settings in this 
example are controlled by resistors RA and RB which pull the enable pin 1 
of UA and UB to ground (low). In a real example, these enable signals are 
controlled by the Microchip IO expander. The default pull-down resistors 
connects the signals EXAMPLE_SIGNAL_A and EXAMPLE_SIGNAL_B and also 
connects signals EXAMPLE_SIGNAL_C and EXAMPLE_SIGNAL_D. To disconnect 
EXAMPLE_SIGNAL_A from EXAMPLE_SIGNAL_B, the Microchip IO expander is 
used to change ENABLE_A to a logic 1 through software that interfaces with 
the Microchip. The same procedure for ENABLE_B disconnects EXAMPLE_
SIGNAL_C from EXAMPLE_SIGNAL_D.

Figure 2-2. Example of Individual FET Switches
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Figure 2-3 shows the equivalent circuit to Figure 2-2 but utilizes mechan-
ical switches that are in the same package. Notice the default is shown by 
black boxes located closer to the ON label of the switches. In order to dis-
connect these switches, physically move the switch to the OFF position.

Figure 2-4 shows a bus switch example, reference designator UC (Pericom 
PI3LVD512ZHE), selecting between lettered functionality and numbered 
functionality. The signals on the left side are multiplexed signals with 
naming convention letter_number. The right side of the circuit shows the 
signals separated into letter and number, with the number on the lower 
group (eg. 0B1) and the letter on the upper group (eg. 0B2). The default 
setting is controlled by the signal CONTROL_LETTER_NUMBER which is pulled 
low. This selects the number signals on the right to be connected to the 
multiplexed signals on the left by default. In this example, the Microchip 
IO expander is not shown but controls the signal CONTROL_LETTER_NUMBER 
and allows the user to change the selection through software.

Figure 2-5 shows the equivalent circuit to Figure 2-4 but utilizes mechan-
ical switches. Notice the default for reference designators SWC and SWD is 
illustrated by black boxes located closer to the ON label of the switches to 
enable the number signals by default. Also notice the default setting for 
reference designators SWE and SWF is OFF. In order to connect the letters 
instead of the numbers, the user physically changes all switches on SWC and 
SWD to the OFF position and all switches on SWE and SEF to the ON position.

Figure 2-3. Example of Mechanical Switch Equivalent to Figure 2-2
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Figure 2-4. Example of Bus Switch 
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 SoftConfig on the ADSP-CM403F EZ-KIT LITE
The Microchip MCP23017 GPIO expander (U27) provides control for 
individual electronic switches. The TWI0 interface of the processor com-
municates with the Microchip device.

Table 2-1 lists the ADSP-CM403F processor and EZ-KIT Lite interfaces 
that are available by default. Note that only interfaces affected by software 
switches are listed in Table 2-1.

Figure 2-5. Example of Mechanical Switch Equivalent to Figure 2-4
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Programming SoftConfig Switches
On the ADSP-CM403F EZ-KIT Lite, one Microchip MCP23017 device 
exists. The device has the following programming characteristics:

• Each switch has two programmable GPIO registers.

• Each GPIO register controls eight signals (software switches).

• By default, the Microchip MCP23017 GPIO signals function as 
input signals.

The signals must be programmed as output signals to override their 
default values. The following table shows the Microchip register 
addresses and the values that must be written to them to program 
the signals as output signals.

Table 2-1. Default ADSP-CM403F Processor Interface Availability

Interface Availability by Default

UART0 RS-232 RX, TX and RTS enabled by default. SoftConfig required for other 
functionality.

CAN0 Enabled in hardware, disabled in software to use LED1.

Push buttons Enabled

LEDs Enabled

GPIO Register Register Address

GPIOA 0x12

GPIOB 0x13

IODIR Register IODIR Register Address Value to be Written to Program Signals 
as Outputs

IODIRA 0x00 0

IODIRB 0x01 0
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Each of the software examples include a source file that programs the soft 
switches, even if the default settings are being used. The README for each 
example identifies only the signals that are being changed from their 
default values. The code that programs the soft switches is located in the 
SoftConfig_CM408F.c file in each example.

Table 2-2 outlines the default values for the Microchip MCP23017 
device.

The ADSP-CM403F EZ-KIT Lite Schematic shows how the Microchip 
GPIO expander (U27) is connected to the board’s ICs. All outputs drive 
single signal FET switches. The CAN0 and LED1 circuits both use pro-
cessor port pin PB_15, and can be selected through SoftConfig. CAN0 
enable (CAN0_EN0) controls whether the CAN port is enabled or the signals 
are connected to the expansion interface. When CAN0_EN is low, the CAN 
interface is enabled and the processor signals (PC_00 and PB_15) are not 
connected to the expansion interface. A CAN0_EN setting of high connects 
the signals to the expansion interface and disconnects the CAN port. This 
is done through the inverter IC (U3).

Table 2-3 and Table 2-4 show the output signals of the Microchip GPIO 
expander (U27), with a TWI address of 0100 001X, where X represents the 
read or write bit. The signals that control an individual FET have an entry 
under the FET column. The Component Connected column shows the 
board IC that is connected if the FET is enabled. Also note that if a 
particular functionality of the processor signal is being used, it will be in 
bold font under the Processor Signal column.

Table 2-2. I2C Hardware Address 0x40

GPIO MCP23017 Register Address Default Value

GPIOA 0x12 0xE0

GPIOB 0x13 0xC1
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Table 2-3. Output Signals of Microchip GPIO Expander 
(U27 Port A)

Bit Signal Name Description FET Processor Signal 
(if applicable)

Component 
Connected

Default

0 Not used Low

1 PB_10_J7_EN Processor pin PB_10 
connection to expan-
sion connector J7

U8 PB_10/SINC0_CLK0/
SPI0_D2/CAN1_RX/
SMC0_AWE/TM0_ACI1

Low

2 PB_11_J7_EN Processor pin PB_11 
connection to expan-
sion connector J7

U9 PB_11/SINC0_D0/
SPI0_D3/CAN1_TX/
SMC0_AMS0/TM0_ACLK1

Low

3 UART0RTS_EN UART0 RTS 
connected to RS-232 
transceiver

U10 PB_04/PWM2_SYNC/
UART0_RTS/SPT0_
ATDV/SMC0_D12/CNT1_
UD

U23 Low

4 UART0RX_EN UART0 RX 
connected to RS-232 
transceiver

U11 PC_01/UART0_RX/
SMC0_A05/TM0_ACI5

U23 Low

5 UART0CTS_EN UART0 CTS 
disconnected from 
RS-232 transceiver 
by default

U12 PB_05/PWM2_TRIP0/
UART0_CTS/TM0_TMR7/
SMC0_D13/CNT1_DG

U36 High

6 UART0CTS_RTS_LPBK UART0 CTS and 
RTS not connected. 
Change to low for 
looping back RS-232 
CTS and RTS signals

U13 U36 High

7 UART0CTS_RST_EN UART0 CTS signal 
not connected to 
input of reset IC

U14 U36 High
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Table 2-4. Output Signals of Microchip GPIO Expander 
(U27 Port B)

Bit Signal Name Description FET Processor Signal 
(if applicable)

Component 
Connected

Default

0 CAN0_EN Enables CAN 0, 
enabled by default

U15/
U16

PC_00/CAN0_TX/
SPT1_BTDV/UART1_
TX/SMC0_A04 and PB_
15/CAN0_RX/SPT1_
ATDV/UART1_RX/
SMC0_A03/TM0_ACI4

U26 Low

1 PUSHBUTTON1_EN PF_10 is used as GPIO 
input for push button 
1, enabled by default

U21 PF_10/ETH0_
PTPCLKIN

U39 Low

2 PUSHBUTTON2_EN PE_08 is used as GPIO 
input for push button 
2, enabled by default

U20 PE_08/ETH0_PTPPPS/
SMC0_A22/CNT2_ZM

U39 Low

3 LED1_GPIO_EN PE_07 is used as GPIO 
output for LED1, 
enabled by default

U19 PE_07/ETH0_
PTPAUXIN/SMC0_A21

U5 Low

4 LED2_GPIO_EN PE_06 is used as GPIO 
output for LED2, 
enabled by default

U18 PE_06/SMC0_A20 U5 Low

5 LED3_GPIO_EN PE_05 is used as GPIO 
output for LED3, 
enabled by default

U17 PE_05/SMC0_A19 U5 Low

6 TRACE_EXP_EN Signals not connected 
to expansion interface

U51–
55

PB_00, PB_01, PB_
02, PB_03, PC_02

J2, J7 High

7 SPIFLASH_J2_EN Signals not connected 
to expansion interface 
by default

U32–
36

PC_03, PC_05, PC_
04, PB_10, PB_11

J2 High
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Push Buttons and Switches
This section describes operation of the push buttons and switches. The 
push button and switch locations are shown in Figure 2-6.

Figure 2-6. Push Button and Boot Mode Switch Locations
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Boot Mode Select Switch (SW1)
The rotary switch (SW1) determines the boot mode of the processor. 
Table 2-5 shows the available boot mode settings. By default, the 
ADSP-CM403F processor boots from the on-board burst flash memory.

Reset Push Button (SW2)
The reset push button (SW2) resets the processor (U1) and the GPIO 
extender (U27). The reset also is connected to the expansion interface via 
the SYS_HWRST signal.

GPIO Push Buttons (SW3-4)
The GPIO push buttons (SW3 and SW4) are connected to the processor’s 
signals PB_06/PWM2_AH/TM0_CLK/SMC0_D14 and PB_07/PWM2_AL/TM0_TMR0/
SMC0_D15, respectively. The signals are connected by default.

Table 2-5. Boot Mode Select Switch (SW1)

SW1 Position Processor Boot Mode

0 No Boot – Idle

1 SPI master boot (internal SPI2). Default boot mode.

2 SPI slave boot (SPI0)

3 UART boot (UART0)
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Jumpers
This section describes functionality of the configuration jumpers. 
Figure 2-7 shows the jumper locations. 

Figure 2-7. Jumper Locations
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VREF0 External Source Jumper (JP1)
The VREF0 external source jumper (JP1) selects whether an internal or 
external voltage reference supplies the VREF0 signal of the processor. When 
a jumper on JP1 is not installed (default), the internal voltage reference 
supplies VREF0. When a jumper on JP1 is installed, the external Analog 
Devices ADR441 ultra-low noise voltage reference (U6) supplies VREF0. 
Configure the processor’s registers accordingly for the latter case.

VREF1 External Source Jumper (JP2)
The VREF1 external source jumper (JP2) selects an internal or external volt-
age reference supply to the VREF1 signal of the processor. When a jumper 
on JP2 is not installed (default), the internal voltage reference supplies 
VREF1. When a jumper on JP2 is installed, the external Analog Devices 
ADR441 ultra-low noise voltage reference (U2) supplies VREF1. Configure 
the processor’s registers accordingly for the latter case.

Buffer Input Select Jumper (JP3)
The buffer input select jumper (JP3) selects the input to the ADA4889 
unity gain op amp buffer (U22). The processor’s internal input is selected 
by placing a jumper on pins 1 and 2 of JP3 (default).

The external VREF0 input, supplied by the Analog Devices ADR441 
ultra-low noise voltage reference (U6), is selected by placing a jumper on 
pins 2 and 3 of JP3.
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Power Select Jumper (JP4)
The power select jumper (JP4) selects the wall power (5V) when a jumper 
is placed on positions 1 and 2. When a jumper is placed on positions 2 
and 3, power from pins 177, 178, 179 and 180 of the PWM connector 
(J7) is supplied to the board. The default setting is positions 1 and 3, 
which selects wall power.

Power Jumpers (P4–6)
Remove jumpers listed in Table 2-6 to measure the respective voltage 
across the adjacent sense resistor.

Table 2-6. Power Jumpers

Power Jumper Resistor

P4 VDD_INT

P5 VDD_EXT

P6 3.3V
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LEDs
This section describes the on-board LEDs. Figure 2-8 shows the LED 
locations. 

Figure 2-8. LED Locations
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GPIO LEDs (LED1–3)
Three LEDs are connected to the general-purpose I/O pins of the proces-
sor (see Table 2-7). The LEDs are active high and are ON (amber) by 
writing a 1 to the correct processor signal.

Reset LED (LED4)
When LED4 is ON (red), it indicates that the master reset of all the major 
ICs is active. The reset LED is controlled by the Analog Devices ADM708 
supervisory reset circuit. A master reset is asserted by pressing SW2 which 
activates LED4. For more information, see Reset Push Button (SW2).

Power LED (LED5)
When LED5 is ON (green), it indicates that power is being supplied to the 
board properly. For more information, see Power Architecture.

SYS_FAULT LED (LED6)
When LED6 is ON (red), it indicates a system fault. For more information, 
refer to the ADSP-CM40x Mixed-Signal Control Processor Hardware 
Reference.

Table 2-7. GPIO LEDs

LED Reference Designator Processor Programmable Flag Pin

LED1 PB_15

LED2 PB_04

LED3 PB_05
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Connectors
This section describes connector functionality and provides information 
about mating connectors. The connector locations are shown in 
Figure 2-9.

 Connectors on the back of the board are noted with dotted lines.

Figure 2-9. Connector Locations
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DCE UART Connector (J1)

Asynch or Memory Connector (J2)

Character Display Connector (J3)
The character display connector (J3) is a socket that mates with the 20  2 
character display.

Part Description Manufacturer Part Number

DB9 female NORCOMP 191-009-213-L-571

Part Description Manufacturer Part Number

180-pin high speed socket SAMTEC QSH-090-F-D_A

Mating Connector

180-pin high speed header SAMTEC QTH-090-01-F-D-A

Part Description Manufacturer Part Number

IDC 5x2 SMT SAMTEC SSW-105-22-F-D-VS

Mating Connector

20x2 character display with back-
light

NEW HAVEN DISPLAY NHD-0220D3Z-FL-GBW 
(requires header)
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PWM Connector (J7)

CAN0 Connector (J8)

Analog Connector (J9)

JTAG/SWD/SWV Connector (P1)
The JTAG/SWD/SWV header (P1) provides debug connectivity for the 
microprocessor. This is a 0.1” connector from SAMTEC 
(SHF-110-01-L-D-TH). For more information, see Debug Interface.

Part Description Manufacturer Part Number

180-pin high speed socket SAMTEC QSH-090-F-D_A

Mating Connector

180-pin high speed header SAMTEC QTH-090-01-F-D-A

Part Description Manufacturer Part Number

RJ11 vertical DIGIKEY A31431-ND

Mating Connector

RJ11 cable

Part Description Manufacturer Part Number

120-pin high speed socket SAMTEC QSH-060-F-D_A

Mating Connector

120-pin high speed header SAMTEC QTH-060-01-F-D-A
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TRACE and JTAG/SWD/SWV Connector (P2)
The TRACE and JTAG/SWD/SWV Connector (P2) provides connectiv-
ity to the microprocessor’s trace interface. This is a 0.05” connector from 
TE Connectivity (5103308-5).

Pin 7 is cut to provide keying.

Refer to the SoftConfig tables for information on enabling the Trace sig-
nals, specifically the TRACE_EXP_EN signal.

VREF Buffered Connector (P3)
The VREF buffered connector provides a means to measure the voltage of 
the voltage reference. There is an adjacent analog grounding point (TP11).

Power Connector (P7)

Part Description Manufacturer Part Number

0.65 mm power jack CUI 045-0883R

Mating Connector

5.0VDC@3.6A power supply GLOBETEK GS-1750(R)
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A ADSP-CM403F EZ-KIT LITE 
BILL OF MATERIALS

The bill of materials corresponds to ADSP-CM403F EZ-KIT Lite 
Schematic.

Ref. Qty Description Reference 
Designator

Manufacturer Part Number

1 1 ADM708SARZ SOIC8 U28 ANALOG 
DEVICES

ADM708SARZ

2 1 ADP2119ACPZ-R7 
DFN50P300X300-11N

VR1 ANALOG 
DEVICES

ADP2119ACPZ-R7

3 2 ADR441ARMZ 
MSOP8

U2,U6 ANALOG 
DEVICES

ADR441ARMZ

4 1 ADP2118ACPZ 
QFN65P400X400X80-
17N

VR2 ANALOG 
DEVICES

ADP2118ACPZ

5 1 ADA4899 SOIC8 U22 ANALOG 
DEVICES

ADA4899-1YRDZ-R7

6 1 ADM3252E 
BGA44C100P11X11_
1200X1200X103

U23 ANALOG 
DEVICES

ADM3252EABCZ

7 1 ADM3053 
SOIC127P1032X265-2
0N

U26 ANALOG 
DEVICES

ADM3053BRWZ

8 1 ADSP-CM403FBSWZ 
QFPS40P1600X1600X
160-121N

U1 ANALOG 
DEVICES

ADSP-CM403FBSWZENG
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9 47 0.1UF 10V 10% 0402 C1,C7,C8,C1
1,C13,C16,C
19,C22,C25-
C30,C33,C42
-C44,C49,C5
1,C52,C55,C
56,C60,C63-
C66,C68,C72
-C74,C76,C7
7,C79,C95,C
99-C104,C11
1,C113-C115,
C174

AVX 0402ZD104KAT2A

10 37 0.01UF 16V 10% 0402 C4-C6,C21,C
23,C34-C40,
C48,C67,C69
,C71,C80-C8
9,C105-C110,
C112,C170-C
173

AVX 0402YC103KAT2A

11 1 10UF 16V 10% 1210 C93 AVX 1210YD106KAT2A

12 2 1000PF 50V 5% 1206 C92,C94 AVX 12065A102JAT2A

13 2 680 1/16W 1% 0402 R140,R141 BC COMPO-
NENTS

2312 275 16801

14 2 1.5UH 20% IND003 L1,L2 COIL CRAFT DO1608C-152MLC

15 1 ROTARY SWT027 SW1 COPAL S-8110

16 1 MCP23017 
QFN65P600X600-29N

U27 DIGI-KEY MCP23017-E/ML-ND

17 1 GREEN LED_0603 LED5 DIGI-KEY 475-1409-2-ND

18 3 0.1UF 16V 10% 0402 C57-C59 DIGI-KEY 587-1451-2-ND

19 1 30MHZ OSC012 U25 DIGI-KEY 300-8257-1-ND

20 2 RED LED_0603 LED4,LED6 DIGI-KEY 475-2512-2-ND

21 3 YELLOW LED_0603 LED1-LED3 DIGI-KEY 475-2558-1-ND

Ref. Qty Description Reference 
Designator

Manufacturer Part Number



ADSP-CM403F EZ-KIT Lite Evaluation System Manual A-3 

ADSP-CM403F EZ-KIT Lite Bill Of Materials

22 1 10UF 6.3V 20% 0402 C15 DIGI-KEY 445-8920-1-ND

23 1 STD2805T4 
TO228P972X240-3N

Q1 DIGI-KEY 497-7465-1-ND

24 7 IDC 2PIN_JUMPER_
SHORT

SJ1-SJ7 DIGI-KEY S9001-ND

25 1 PWR .65MM CON045 P7 DIGI-KEY CP1-023-ND

26 1 1K 1/10W 5% 0603 R20 DIGI-KEY 311-1.0KGRTR-ND

27 1 4700PF 16V 10% 0603 C70 DIGI-KEY 311-1083-2-ND

28 2 100 1/16W 5% 0402 R95,R96 DIGI-KEY 311-100JRTR-ND

29 6 330.0 1/16W 1% 0402 R28,R77-R80,
R91

DIGI-KEY 541-330LCT-ND

30 6 IDC 2X1 IDC2X1 JP1,JP2,P3-P6 FCI 90726-402HLF

31 2 IDC 3X1 IDC3X1 JP3,JP4 FCI 90726-403HLF

32 1 IDT74FCT3244APY 
SSOP20

U5 IDT IDT74FCT3244APYG

33 1 TEST LOOP LOOP_
2838

GP1 KEYSTONE 5016

34 3 0 1/4W 5% 1206 R15,R21,R13
8

KOA 0.0ECTRk7372BTTED

35 1 IDC 10X2 TE_
5103308-5

P1 MOUSER 571-5103308-5

36 7 10UF 6.3V 20% 0603 C9,C10,C18,
C24,C31,C32
,C41

MULTICOMP MCCA000517

37 1 190 100MHZ 5A 
FER002

FER3 MURATA DLW5BSN191SQ2

38 1 DB9 9PIN CON038 J1 NORCOMP 191-009-213-L-571

39 1 GTL2002 TSSOP8 U24 NPX GTL2002DP,118

Ref. Qty Description Reference 
Designator

Manufacturer Part Number



A-4 ADSP-CM403F EZ-KIT Lite Evaluation System Manual

40 3 5A MBRS540T3G 
SMC

D4,D6,D7 ON SEMI MBRS540T3G

41 3 MOMENTARY 
SWT024

SW2-SW4 PANASONIC EVQ-Q2K03W

42 13 0 1/16W 5% 0402 R6,R7,R19,R
32,R37,R103,
R108,R110,R
122,R131,R13
3,R135,R139

PANASONIC ERJ-2GE0R00X

43 25 0 1/16W 5% 0402 R5,R18,R33,
R36,R68,R10
5,R106,R111,
R114-R119,R
121,R123,R12
7,R128,R132,
R134,R136,R
137,R147-R1
49

PANASONIC ERJ-2GE0R00X

44 3 1UF 6.3V 20% 0402 C17,C90,C91 PANASONIC ECJ-0EB0J105M

45 7 10UF 10V 10% 0805 C12,C14,C20
,C61,C62,C7
5,C78

PANASONIC ECJ-2FB1A106K

46 2 27K 1/16W 5% 0402 R30,R31 PANASONIC ERJ-2GEJ273X

47 2 60.4 1/10W 1% 0603 R67,R70 PANASONIC ERJ-3EKF60R4V

48 1 45.3K 1/10W 1% 0402 R113 PANASONIC ERJ-2RKF4532X

49 1 24.9 1/10W 1% 0402 R12 PANASONIC ERJ-2RKF24R9X

50 1 10UF 10V 20% ELEC_
4MM

CT1 PANASONIC EEE-1AA100NR

51 26 PI3A125 SC70_5 U8-U21,U32-
U38,U51-U55

PERICOM PI3A125CEX

52 4 0.0 1/10W 1% 0603 R13,R14,R16,
R17

PHYCOMP 232270296001L

Ref. Qty Description Reference 
Designator

Manufacturer Part Number



ADSP-CM403F EZ-KIT Lite Evaluation System Manual A-5 

ADSP-CM403F EZ-KIT Lite Bill Of Materials

53 1 200.0K 1/16W 1% 
0402

R142 ROHM MCR01MZPF2003

54 1 IDC 5X2 IDC5x2_
SMT_F

J3 SAMTEC SSW-105-22-F-D-VS

55 1 0.05 10X2 SAMTEC_
SHF-110-01-L-D-TH

P2 SAMTEC SHF-110-01-L-D-TH

56 2 0.5MM 180PIN SAM-
TEC_QSH-090-F-D-A

J2,J7 SAMTEC QSH-090-01-F-D-A

57 1 0.5MM 120PIN SAM-
TEC_QSH-060-F-D-A

J9 SAMTEC QSH-060-01-F-D-A

58 3 0.051 OHM 1/2W 1% 
1206

R38,R102,R1
09

SEI CSF 1/2 0.05 1%R

59 2 600 100MHZ 500MA 
1206

FER1,FER2 STEWARD HZ1206B601R-10

60 1 74LVC14A SOIC14 U3 TI 74LVC14AD

61 1 SN74LVC1G08 
SOT23-5

U31 TI SN74LVC1G08DBVE

62 2 SN74LVC1G08 
SOT23-5

U29,U30 TI SN74LVC1G08DBVE

63 1 RJ11 4PIN CON039 J8 TYCO 5558872-1

64 1 3A RESETABLE 
FUS004

F1 TYCO SMD300F-2

65 1 0 1/8W 5% 0805 R10 VISHAY CRCW08050000Z0EA

Ref. Qty Description Reference 
Designator

Manufacturer Part Number



A-6 ADSP-CM403F EZ-KIT Lite Evaluation System Manual

66 54 10K 1/16W 5% 0402 R1,R8,R11,R
24-R27,R29,R
35,R41-R43,R
45,R46,R55-R
61,R64-R66,R
69,R73-R76,R
81-R90,R92,R
93,R97-R100,
R104,R112,R
124,R125,R14
3-R146,R224

VISHAY CRCW040210K0FKED

67 9 10K 1/16W 5% 0402 R2-R4,R23,R
39,R40,R44,R
54,R126

VISHAY CRCW040210K0FKED

68 1 4.7K 1/16W 5% 0402 R22 VISHAY CRCW04024K70JNED

69 6 33 1/16W 5% 0402 R9,R62,R63,
R94,R101,R1
20

VISHAY CRCW040233R0JNEA

70 4 10 1/10W 5% 0603 R34,R71,R72,
R107

VISHAY CRCW060310R0JNEA

71 1 30A GSOT05 SOT23-3 D2 VISHAY GSOT05-GS08

72 2 30A GSOT03 SOT23-3 D1,D3 VISHAY GSOT03-GS08

73 6 22UF 16V 10% 1210 C45-C47,C96
-C98

YAIYO 
YUDEN

EMK325BJ226KM-T

Ref. Qty Description Reference 
Designator

Manufacturer Part Number



1.0
1 10

A0342-2012

ADSP-CM403F EZ-KIT
TITLE

08/27/2013

D

4

3

2

1

A B C

20 Cotton Road

Nashua, NH 03063

A B C D

4

3

2

1

PH: 1-800-ANALOGD

C

Title

Size Board No.

Date Sheet of

DEVICES
ANALOG

Rev

ADSP-CM403F EZ-KIT
SCHEMATIC



08/27/2013
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A0342-2012
102

1.0

D

4

3

2

1

A B C

20 Cotton Road

Nashua, NH 03063

A B C D

4

3

2

1

PH: 1-800-ANALOGD

C

Title

Size Board No.

Date Sheet of

DEVICES
ANALOG

Rev

U1

ADSP-CM403BSWZ
QFPS40P1600X1600X160-121N

47

46

48

51

50

102

104

103

106

105

107

110

117

115

111

112

113

114

45

42

41

40

39

38

37

35

19

15

14

13

12

11

10

8

7

6

5

4

3

1PA_13/PWM1_AL/TM0_TMR5/SMC0_D05

PA_12/PWM1_AH/TM0_TMR4/SMC0_D04

PA_11/PWM1_TRIP0/UART1_CTS/SMC0_D03/TM0_ACLK2

PA_10/PWM1_SYNC/SMC0_D02/TM0_ACLK3

PA_09/PWM1_CL/SMC0_D01/TM0_ACLK4

PA_08/PWM1_CH/SMC0_D00/TM0_ACLK5

PA_07/PWM0_CL/SMC0_AMS2/SPT1_BD1

PA_06/PWM0_CH/SPT1_BD0

PA_05/PWM0_BL/SPT1_BFS

PA_04/PWM0_BH/SPT1_BCLK

PA_03/PWM0_AL/SPT1_AD1

PA_02/PWM0_AH/SPT1_AD0

PA_01/PWM0_TRIP0/SPT1_AFS

PA_00/PWM0_SYNC/SPT1_ACLK

PC_07/SINC0_CLK1/UART2_TX/UART1_RTS/SYS_DSWAKE1

PC_06/SPI0_SEL1/PWM2_DL/SYS_DSWAKE0

PC_05/SPI0_MOSI/PWM2_DH

PC_04/SPI0_MISO/PWM2_CL

PC_03/SPI0_CLK/PWM2_CH

PC_02/UART0_TX/TRACE_D3/SPI0_RDY

PC_01/UART0_RX/SMC0_A05/TM0_ACI5

PC_00/CAN0_TX/SPT1_BTDV/UART1_TX/SMC0_A04

PB_00/PWM0_DH/TRACE_CLK/SPT0_ACLK/SMC0_D08/CNT0_ZM

PB_01/PWM0_DL/TRACE_D0/SPT0_AFS/SMC0_D09/CNT0_UD

PB_02/PWM1_DH/TRACE_D1/SPT0_AD0/SMC0_D10/CNT0_DG

PB_03/PWM1_DL/TRACE_D2/SPT0_AD1/SMC0_D11/CNT1_ZM

PA_15/PWM1_BL/TM0_TMR3/SMC0_D07

PA_14/PWM1_BH/TM0_TMR6/SMC0_D06

PB_04/PWM2_SYNC/UART0_RTS/SPT0_ATDV/SMC0_D12/CNT1_UD

PB_05/PWM2_TRIP0/UART0_CTS/TM0_TMR7/SMC0_D13/CNT1_DG

PB_06/PWM2_AH/TM0_CLK/SMC0_D14

PB_07/PWM2_AL/TM0_TMR0/SMC0_D15

PB_08/PWM2_BH/TM0_TMR1/UART1_RX/SMC0_ARDY/TM0_ACI2

PB_09/PWM2_BL/TM0_TMR2/UART1_TX/SMC0_ARE

PB_10/SINC0_CLK0/SPI0_D2/CAN1_RX/SMC0_AWE/TM0_ACI1

PB_11/SINC0_D0/SPI0_D3/CAN1_TX/SMC0_AMS0/TM0_ACLK1

PB_12/SINC0_D1/UART2_RX/SMC0_AOE/TM0_ACI3

PB_13/SINC0_D2/CNT0_OUTA/SPI0_SEL2/SMC0_A01/TM0_ACLK0/SYS_DSWAKE3

PB_14/SINC0_D3/CNT0_OUTB/SPI0_SEL3/SMC0_A02/SPI0_SS/SYS_DSWAKE2

PB_15/CAN0_RX/SPT1_ATDV/UART1_RX/SMC0_A03/TM0_ACI4

U1

ADSP-CM403BSWZ
QFPS40P1600X1600X160-121N

18

32

33

30

34

31

20

99

21

23

118

24

119

120

29

28TWI0_SCL

TWI0_SDA

SYS_BMODE0

SYS_BMODE1

SYS_CLKIN

SYS_CLKOUT

SYS_XTAL

SYS_HWRST

SYS_NMI

SYS_FAULT

JTG_TCK/SWCLK

JTG_TMS/SWDIO

JTG_TDI

JTG_TDO/SWO

JTG_TRST

SYS_RESOUT

C49

0402
0.1UF

3.3V

R122
DNP
0

0402

Y1

DNP

30MHZ
OSC013

TP10

R6

0402
0

DNP

R7

DNP

0
0402

C2

DNP

18PF
0402

U25

30MHZ
OSC012

GND
2

OE1 OUT3
VDD

4

C3

DNP

18PF
0402

R8
10K
0402

TP1

3.3V

3.3V

3.3V

R9
33
0402

C4
0.01UF
0402

0402
0R121

C1

0402
0.1UF

3.3V

3.3V

R1

0402
10K

R119 0
0402

DNP

R2

0402
10K

DNP

R3

0402
10K

DNP

R4

0402
10K

3.3V

R114 0
0402

R115 0
0402
R116 0
0402
R117 0
0402
R118 0
0402

R5 0
0402

R120 33
0402

P2

SAMTEC_SHF-110-01-L-D-TH

20

18

16

19

17

15

11

13

9

1

3

5

7

4

2

6

10

8

12

14

R123 0
0402

R124

0402
10K

R125

0402
10K

P1

TE_5103308-5

20

18

16

19

17

15

11

13

9

1

3

5

7

4

2

6

10

8

12

14

DNP

R126
10K
0402

U31

DNP

SOT23-5
SN74LVC1G08

4
2

1

R127
0402

0

3.3V

R128 0
0402

PB_08/PWM2_BH/TM0_TMR1/UART1_RX/SMC0_ARDY/TM0_ACI2

PB_09/PWM2_BL/TM0_TMR2/UART1_TX/SMC0_ARE

PC_01/UART0_RX/SMC0_A05/TM0_ACI5

PB_04/PWM2_SYNC/UART0_RTS/SPT0_ATDV/SMC0_D12/CNT1_UD

PB_05/PWM2_TRIP0/UART0_CTS/TM0_TMR7/SMC0_D13/CNT1_DG

PB_10/SINC0_CLK0/SPI0_D2/CAN1_RX/SMC0_AWE/TM0_ACI1

PB_11/SINC0_D0/SPI0_D3/CAN1_TX/SMC0_AMS0/TM0_ACLK1

PB_15/CAN0_RX/SPT1_ATDV/UART1_RX/SMC0_A03/TM0_ACI4

PC_03/SPI0_CLK/PWM2_CH

PC_04/SPI0_MISO/PWM2_CL

PC_05/SPI0_MOSI/PWM2_DH

PC_06/SPI0_SEL1/PWM2_DL/SYS_DSWAKE0

JTG_TRST

JTG_TRST

JTG_TRST

JTG_TDI

JTG_TDI

JTG_TDI

JTG_TMS/SWDIO

JTG_TMS/SWDIO

JTG_TMS/SWDIO

JTG_TCK/SWCLK

JTG_TCK/SWCLK

JTG_TCK/SWCLK

JTG_TDO/SWO

JTG_TDO/SWO

JTG_TDO/SWO

JTAG_BOARD_RESET

JTAG_BOARD_RESET

SYS_HWRST

SYS_HWRST

TWI0_SDA

TWI0_SCL

SYS_CLKOUT

SYS_NMI

PA_07/PWM0_CL/SMC0_AMS2/SPT1_BD1

PA_08/PWM1_CH/SMC0_D00/TM0_ACLK5

PA_09/PWM1_CL/SMC0_D01/TM0_ACLK4

PA_11/PWM1_TRIP0/UART1_CTS/SMC0_D03/TM0_ACLK2

PA_12/PWM1_AH/TM0_TMR4/SMC0_D04

PA_13/PWM1_AL/TM0_TMR5/SMC0_D05

PA_14/PWM1_BH/TM0_TMR6/SMC0_D06

PA_15/PWM1_BL/TM0_TMR3/SMC0_D07

PB_13/SINC0_D2/CNT0_OUTA/SPI0_SEL2/SMC0_A01/TM0_ACLK0/SYS_DSWAKE3

PB_14/SINC0_D3/CNT0_OUTB/SPI0_SEL3/SMC0_A02/SPI0_SS/SYS_DSWAKE2

PC_00/CAN0_TX/SPT1_BTDV/UART1_TX/SMC0_A04

PA_06/PWM0_CH/SPT1_BD0

PA_05/PWM0_BL/SPT1_BFS

PA_04/PWM0_BH/SPT1_BCLK

PA_03/PWM0_AL/SPT1_AD1

PA_02/PWM0_AH/SPT1_AD0

PA_01/PWM0_TRIP0/SPT1_AFS

PA_00/PWM0_SYNC/SPT1_ACLK

SYS_XTAL

SYS_XTAL

SYS_CLKIN

SYS_CLKIN

SYS_CLKIN

SYS_RESOUT

SYS_FAULT

SYS_BMODE1

SYS_BMODE0

PA_10/PWM1_SYNC/SMC0_D02/TM0_ACLK3

PC_07/SINC0_CLK1/UART2_TX/UART1_RTS/SYS_DSWAKE1

PB_06/PWM2_AH/TM0_CLK/SMC0_D14

PB_07/PWM2_AL/TM0_TMR0/SMC0_D15

PB_12/SINC0_D1/UART2_RX/SMC0_AOE/TM0_ACI3

PB_00/PWM0_DH/TRACE_CLK/SPT0_ACLK/SMC0_D08/CNT0_ZM

PB_00/PWM0_DH/TRACE_CLK/SPT0_ACLK/SMC0_D08/CNT0_ZM

JTG_TRST_CONN

JTG_TRST_CONN

JTG_TRST_CONN

JTG_TRST_CONN

PB_01/PWM0_DL/TRACE_D00/SPT0_AFS/SMC0_D09/CNT0_UD

PB_01/PWM0_DL/TRACE_D00/SPT0_AFS/SMC0_D09/CNT0_UD

PB_02/PWM1_DH/TRACE_D01/SPT0_AD0/SMC0_D10/CNT0_DG

PB_02/PWM1_DH/TRACE_D01/SPT0_AD0/SMC0_D10/CNT0_DG

PB_03/PWM1_DL/TRACE_D02/SPT0_AD1/SMC0_D11/CNT1_ZM

PB_03/PWM1_DL/TRACE_D02/SPT0_AD1/SMC0_D11/CNT1_ZM

TRACE_D01/JTG_TRST

TRACE_D01/JTG_TRST

PC_02/UART0_TX/TRACE_D03/SPI0_RDY

PC_02/UART0_TX/TRACE_D03/SPI0_RDY

OPTIONAL DSP CRYSTAL

DSP OSC

pin 7 cut

TRACE AND JTAG/SWD

JTAG/SWD
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3.3V

AGND

AGND

DNP

J5

AMPHENOL_152119
SMC

AGND

AGND

5V

R11
10K
0402

R149

0402
0

0402
0R137R12 24.9

0402

AGND

DNP

J4

AMPHENOL_152119
SMC

C15
10UF
0402

CT1
10UF
ELEC_4MM

R10
0
0805

AGND

3.3V

AGND

R13 0.0
0603

R14 0.0
0603

C7
0.1UF
0402

C8
0.1UF
0402

AGND

AGND

U22

ADA4899
SOIC127P602X147-9N

9

1 8

7

54

63

2-IN

+IN VOUT

-VS0 -VS1

+VS

DISABLEFEEDBACK

G
N

D
P3

IDC2X1

2

1

SJ1

DEFAULT=UNINSTALLED
JUMPER
SHORTING

JP1

IDC2X1

2

1

AGND

TP11

SJ2

DEFAULT=UNINSTALLED
JUMPER
SHORTING

SJ3

DEFAULT=1 & 2
JUMPER
SHORTING

JP3

IDC3X1

3

2

1

JP2

IDC2X1

2

1

AGND

C9
10UF
0603

U1

ADSP-CM403BSWZ
QFPS40P1600X1600X160-121N

75

56
94

81

89
91
92
93

61
90
71
79

73
77

74
76

55
72
78

70
80

82
83
84
85
86
87
88 ADC0_VIN04

ADC0_VIN05
ADC0_VIN06
ADC0_VIN07
ADC0_VIN08
ADC0_VIN09
ADC0_VIN10

ADC1_VIN0866

ADC1_VIN0057

ADC1_VIN0158

ADC1_VIN0259

ADC1_VIN0360

ADC1_VIN0462

ADC1_VIN0563

ADC1_VIN0664

ADC1_VIN0765

VDD_ANA0
VDD_ANA1

BYP_A0
BYP_A1
BYP_D0

GND_VREF0
GND_VREF1

VREF0
VREF1

GND_ANA0
GND_ANA1
GND_ANA2
GND_ANA3

ADC0_VIN00
ADC0_VIN01
ADC0_VIN02
ADC0_VIN03

ADC0_VIN11

ADC1_VIN0967

ADC1_VIN1068

ADC1_VIN1169

DAC0_VOUT
DAC1_VOUT

REFCAP

C10
10UF
0603

AGND

C11
0.1UF
0402

AGND

C12
10UF
0805

AGNDAGND

C13
0.1UF
0402

C14
10UF
0805

AGND

C16
0.1UF
0402

AGND

3.3V 3.3V

C17
1UF
0402

C18
10UF
0603

AGND

AGND

5V

AGND

J9

SAMTEC_QSH-060-F-D-A

1
3
5
7
9

11
13
15
17
19
21
23
25
27
29
31
33
35
37
39
41
43
45
47
49
51
53
55
57
59

2
4
6
8
10
12
14
16
18
20
22
24
26
28
30
32
34
36
38
40
42
44
46
48
50
52
54
56
58
60

61
63
65
67
69
71
73
75
77
79
81
83
85
87
89
91
93
95
97
99

101
103
105
107
109
111
113
115
117
119

62
64
66
68
70
72
74
76
78
80
82
84
86
88
90
92
94
96
98
100
102
104
106
108
110
112
114
116
118
120

121

123

125

127
122

124

126

128

12
7

12
6

12
5

12
8

12
4

12
3

12
2

12
1

ADC

VREF

DAC

RESERVED

POWER

5V

5V

0.01UF
0402

C5

C100

0402
0.1UF

C101

0402
0.1UF

DNP

R129
10K
0603

DNP

R130
10K
0603

C102

0402
0.1UF

R131

DNP

0

0402

C103

0402
0.1UF

AGND

3.3V

U6

MSOP8
ADR441ARMZ

8

4 5

6

1

2VIN

TP0

VOUT

TRIMGND

TP1

R132
0
0402

R133

DNP

0
0402

R134
0
0402

R135

DNP

0
0402

R136
0
0402

U2

MSOP8
ADR441ARMZ

8

4 5

6

1

2VIN

TP0

VOUT

TRIMGND

TP1

C104

0402
0.1UF

C50

DNP

27PF
0402

AGND

R147 0
0402

R148 0
0402

ADC0_VIN00

ADC0_VIN00

ADC0_VIN01
ADC0_VIN01

ADC0_VIN03
ADC0_VIN03

ADC1_VIN08

ADC1_VIN08

ADC1_VIN09

ADC1_VIN09

ADC1_VIN10

ADC1_VIN10

ADC1_VIN11

ADC1_VIN11

ADC1_VIN07

ADC1_VIN07

DAC0_VOUT

DAC0_VOUT

DAC1_VOUT

DAC1_VOUT

ADC0_VIN05
ADC0_VIN05

ADC0_VIN07
ADC0_VIN07

ADC0_VIN09
ADC0_VIN09

ADC0_VIN11
ADC0_VIN11

BUFFER_IN

BUFFER_IN

VREF0_ADR441

VREF0_ADR441

VREF0_ADR441

VREF1_ADR441

VREF1_ADR441

VREF_BUFFERED

VREF_BUFFEREDVREF_BUFFERED

VREF_BUFFERED

VREF0

VREF0

VREF0

VREF0

VREF1

VREF1

VREF1

REFCAP

REFCAP

BYP_A0

BYP_A0

BYP_D0

BYP_D0

BYP_A1

BYP_A1

ADC0_VIN06

ADC0_VIN06

ADC0_VIN08

ADC0_VIN08

ADC0_VIN10

ADC0_VIN10

ADC1_VIN06
ADC1_VIN06

ADC0_VIN02

ADC0_VIN02

DAC0_VOUT_SMC

DAC0_VOUT_EXP_CONN

DAC0_VOUT_EXP_CONN

ADC1_VIN04_SMC

ADC0_VIN04

ADC0_VIN04

ADC0_VIN04_SMC

ADC0_VIN04_EXP_CONN

ADC0_VIN04_EXP_CONN

ADC1_VIN00

ADC1_VIN00

ADC1_VIN01

ADC1_VIN01

ADC1_VIN02

ADC1_VIN02

ADC1_VIN03

ADC1_VIN03

ADC1_VIN04

ADC1_VIN04

ADC1_VIN05

ADC1_VIN05

ADC1_VIN04_EXP_CONN

ADC1_VIN04_EXP_CONN

ANALOG CONN

Pins 70-71Pins 78-79Pins 77-76Pins 75-74Pins 73-74Pins 72-71Pins 80-79Pins 55-
Center pad
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D

4

3

2

1

A B C

20 Cotton Road
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A B C D

4

3

2

1

PH: 1-800-ANALOGD

C

Title

Size Board No.

Date Sheet of

DEVICES
ANALOG

Rev

LED_0603
RED
LED6

Q1
STD2805T4
TO228P972X240-3N

1

3

2

TP12

TP3

R23

DNP

10K
0402

10K
0402

R29

3.3V

R25

0402
10K

3.3V3.3V TP5

R26
10K
0402

R27
10K
0402

TP6TP7

R28

0402
330.0

3.3V

3.3V

C21

0402
0.01UF

C22
0.1UF
0402

C23

0402
0.01UF

C24

0603
10UF

C25
0.1UF
0402

C26
0.1UF
0402

C27
0.1UF
0402

C28
0.1UF
0402

C29
0.1UF
0402

C30
0.1UF
0402

C31

0603
10UF

C32

0603
10UF

C33
0.1UF
0402

C34

0402
0.01UF

C35

0402
0.01UF

C36

0402
0.01UF

C37

0402
0.01UF

C38

0402
0.01UF

C39

0402
0.01UF

C40

0402
0.01UF

DNP

R22
4.7K
0402

U1

ADSP-CM403BSWZ
QFPS40P1600X1600X160-121N

98

121

52

26

25

100
95

116
109
101

97
53
49
43
36
27
22
17
9
2

108
96
54
44
16 VDD_INT0

VDD_INT1
VDD_INT2
VDD_INT3
VDD_INT4

VDD_EXT0
VDD_EXT1
VDD_EXT2
VDD_EXT3
VDD_EXT4
VDD_EXT5
VDD_EXT6
VDD_EXT7
VDD_EXT8
VDD_EXT9
VDD_EXT10
VDD_EXT11
VDD_EXT12
VDD_EXT13
VDD_EXT14

VREG_BASE

VDD_VREG

GND0

GND_PADDLE

GND1

10K
0402

R24

C41

0603
10UF

C42

0402
0.1UF

AGND

R30

0402
27K

R31

0402
27K

DNP

R32

0402
0

C43

0402
0.1UF C44

0.1UF
0402

R33

0402
0

R34

0603
10

DNP

R138
0
1206

5V

C45

1210
22UF

TP13

TP8

D4
MBRS540T3G

SMC

L1

IND003
1.5UH

R35
10K
0402

R36
0
0402

R37
0
0402
DNP

C46

1210
22UF

C47

1210
22UF

D1
GSOT03

SOT23-3

SJ4

DEFAULT=INSTALLED
JUMPER
SHORTING

P4

IDC2X1

1 2

R38
0.05
1206

VR1

ADP2119ACPZ-R7
DFN50P300X300-11N

7

11

6

8

10

5

2

9

4

3

1VIN

SW

PGND

SYNC/MODE

PVIN

GND

EN

PGOOD

FB

EPAD

TRK

3.3V

DNP

R15
0
1206

R16
0.0
0603

R17
0.0
0603

R18
0
0402

3.3V

R19

DNP

0
0402

R20

0603
1K

C19

0402
0.1UF

C20

0805
10UF

DNP

R21

1206
0

JTG_TRSTSYS_HWRST

TWI0_SDA

TWI0_SCL

SYS_CLKOUT

SYS_NMI

SYS_RESOUT

SYS_FAULT

VDD_INT

VDD_INT

VDD_INT

VDD_INT

VDD_EXT

VDD_EXT

VDD_EXT

"FAULT"

REMOVE R21, R15, R32

INSTALL R17, R16, P4, R38, R33

INTERNAL REGULATOR

REMOVE R17, R16, P4, R38, R33

INSTALL R21, R15, R32

NOTE:

Remove P4 when measuring VDD_INT

NOTE: CONNECT PIN 98 DIRECTLY TO GROUND

FOR CUSTOMER DESIGNS

Pins 95-90

EXTERNAL REGULATOR

1.2V @ 1.5A "VDD_INT"
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Date Sheet of
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Rev

C48
0.01UF
0402

R45
10K
0402

R46
10K
0402

U8

PI3A125
SC70_5

2 4

1OE

BA

U9

PI3A125
SC70_5

2 4

1OE

BA

C51

0402
0.1UF

C52

0402
0.1UF

3.3V

3.3V

R39

DNP

10K
0402

SOIC14
74LVC14A

U3

21

C6

0402
0.01UF

R40

DNP

10K
0402

R41
10K
0402

3.3V

R42
10K
0402

U27

MCP23017
QFN65P600X600-29N

17

18

19

20

5

8

9

14

16

15

11

12

28

24

23

27

22

26

21

25

1

2

3

413A2 GPB7

GPB6

GPB5

GPB4

GPB0

GPA4

GPB1

GPA5

GPB2

GPA6

GPA7

GPB3

A1

A0

INTB

INTA

RESET

SDA

SCL

VDD

GPA3

GPA2

GPA1

GPA0

R43
10K
0402

R44
10K
0402
DNP

SC70_5
PI3A125

U55

2 4

1OE

BA

PI3A125
SC70_5

U54

2 4

1OE

BA

SC70_5
PI3A125

U53

2 4

1OE

BA

PI3A125
SC70_5

U52

2 4

1OE

BA

PI3A125
SC70_5

U51

2 4

1OE

BA

0402
10K
R224

3.3V

3.3V

0.1UF
0402

C174
0.01UF
0402

C173
0.01UF
0402

C172
0.01UF
0402

C171
0.01UF
0402

C170

U32

SC70_5
PI3A125

2 4

1OE

BA

U33

SC70_5
PI3A125

2 4

1OE

BA

U34

PI3A125
SC70_5

2 4

1OE

BA

U35

SC70_5
PI3A125

2 4

1OE

BA

U36

PI3A125
SC70_5

2 4

1OE

BA

3.3V

R100
10K
0402

C108

0402
0.01UF

C109

0402
0.01UF

U37

SC70_5
PI3A125

2 4

1OE

BA

U38

SC70_5
PI3A125

2 4

1OE

BA

C110

0402
0.01UF

C111

0402
0.1UF

3.3V

C112

0402
0.01UF

3.3V

C113

0402
0.1UF

UART0RTS_EN

UART0RX_EN

UART0CTS_RTS_LPBK

UART0CTS_RST_EN

UART0CTS_EN

PB_10/SINC0_CLK0/SPI0_D2/CAN1_RX/SMC0_AWE/TM0_ACI1

PB_10/SINC0_CLK0/SPI0_D2/CAN1_RX/SMC0_AWE/TM0_ACI1

PB_11/SINC0_D0/SPI0_D3/CAN1_TX/SMC0_AMS0/TM0_ACLK1

PB_11/SINC0_D0/SPI0_D3/CAN1_TX/SMC0_AMS0/TM0_ACLK1

PB_15/CAN0_RX/SPT1_ATDV/UART1_RX/SMC0_A03/TM0_ACI4

PC_03/SPI0_CLK/PWM2_CH

PC_04/SPI0_MISO/PWM2_CL

PC_05/SPI0_MOSI/PWM2_DH

SYS_HWRST

LED3_GPIO3_EN

LED2_GPIO2_EN

LED1_GPIO1_EN

PUSHBUTTON1_EN

PUSHBUTTON2_EN

TWI0_SDA

TWI0_SCL

PC_00/CAN0_TX/SPT1_BTDV/UART1_TX/SMC0_A04

CAN0_EN

CAN0_EN

PB_00/PWM0_DH/TRACE_CLK/SPT0_ACLK/SMC0_D08/CNT0_ZM

TRACE_EXP_EN

TRACE_EXP_EN

PB_00/PWM0_DH/TRACE_CLK/SPT0_ACLK/SMC0_D08/CNT0_ZM_EXP

PB_15/CAN0_RX/SPT1_ATDV/UART1_RX/SMC0_A03/TM0_ACI4_EXP

CAN0_EN_INVERTED

CAN0_EN_INVERTED

PC_00/CAN0_TX/SPT1_BTDV/UART1_TX/SMC0_A04_EXP

PB_01/PWM0_DL/TRACE_D00/SPT0_AFS/SMC0_D09/CNT0_UD

PB_02/PWM1_DH/TRACE_D01/SPT0_AD0/SMC0_D10/CNT0_DG

PB_03/PWM1_DL/TRACE_D02/SPT0_AD1/SMC0_D11/CNT1_ZM

PB_01/PWM0_DL/TRACE_D00/SPT0_AFS/SMC0_D09/CNT0_UD_EXP

PB_02/PWM1_DH/TRACE_D01/SPT0_AD0/SMC0_D10/CNT0_DG_EXP

PB_03/PWM1_DL/TRACE_D02/SPT0_AD1/SMC0_D11/CNT1_ZM_EXP

PC_02/UART0_TX/TRACE_D03/SPI0_RDY_EXPPC_02/UART0_TX/TRACE_D03/SPI0_RDY

PB_11/SINC0_D0/SPI0_D3/CAN1_TX/SMC0_AMS0/TM0_ACLK1_J7

PB_10/SINC0_CLK0/SPI0_D2/CAN1_RX/SMC0_AWE/TM0_ACI1_J7

PB_10_J7_EN

PB_10_J7_EN

PB_11_J7_EN

PB_11_J7_EN

PC_03/SPI0_CLK/PWM2_CH_J2

PC_05/SPI0_MOSI/PWM2_DH_J2

PC_04/SPI0_MISO/PWM2_CL_J2

PB_10/SINC0_CLK0/SPI0_D2/CAN1_RX/SMC0_AWE/TM0_ACI1_J2

PB_11/SINC0_D0/SPI0_D3/CAN1_TX/SMC0_AMS0/TM0_ACLK1_J2

SPIFLASH_J2_EN

SPIFLASH_J2_EN

THE OTHER GATES OF U3 ON PUSHBUTTON PAGE

SOFTCONFIG

I2C address 0100 000
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DEVICES
ANALOG

Rev

J1

DB9
CON038

9

8

7

6

5

4

3

2

1

SW1

ROTARY
SWT027

4

2

1C

0

1
2

3

4

5
6

7

C66
0.1UF
0402

C62
10UF
0805

3.3V

C55
0.1UF
0402

3.3V

C57
0.10UF
0402

C58
0.10UF
0402

C59
0.10UF
0402

GND2

3.3V

R54

DNP

10K
0402

R55
10K
0402

R56
10K
0402

R57
10K
0402

U12

PI3A125
SC70_5

2 4

1OE

BA

U10

PI3A125
SC70_5

2 4

1OE

BA

R58

0402
10K

3.3V

R59
10K
0402

R60
10K
0402

R61
10K
0402

U13

PI3A125
SC70_5

2 4

1OE

BA

U14

PI3A125
SC70_5

2 4

1OE

BA

R62
0402

33

R63
0402

33

GND2

C56
0.1UF
0402

C60
0.1UF
0402

GND2

3.3V

C61
10UF
0805

U23

ADM3252E
BGA44C100P11X11_1200X1200X103

C10
B10
A10

B2
B1
A2

L10
K10
J10
H10
F10
E10
D10

L2
K2
J2
J1
H2
G2
G1
F2
E2
E1
D2
C2
C1

K11
H11

F11
D11

J11

B11

K1
H1

F1
D1

G10

G11

E11

C11C1+

C1-

C2+

C2-

TIN1
TIN2

ROUT1
ROUT2

V+

V-

TOUT1
TOUT2

RIN1
RIN2

GND0
GND1
GND2
GND3
GND4
GND5
GND6
GND7
GND8
GND9
GND10
GND11
GND12

GND_ISO0
GND_ISO1
GND_ISO2
GND_ISO3
GND_ISO4
GND_ISO5
GND_ISO6

VCC0
VCC1
VCC2

VISO0
VISO1
VISO2

R64
10K
0402

R65

0402
10K

R66
10K
0402

C63
0.1UF
0402

3.3V

C64
0.1UF
0402

C65
0.1UF
0402

U11

PI3A125
SC70_5

2 4

1OE

BA

0402
0.1UF
C114

0402
0.1UF
C115

UART0RTS_EN

UART0RX_EN

UART0CTS_RTS_LPBK

UART0CTS_RST_EN

UART0CTS_EN

PC_01/UART0_RX/SMC0_A05/TM0_ACI5

PB_04/PWM2_SYNC/UART0_RTS/SPT0_ATDV/SMC0_D12/CNT1_UD

PB_05/PWM2_TRIP0/UART0_CTS/TM0_TMR7/SMC0_D13/CNT1_DG

CTS

SYS_BMODE1

SYS_BMODE0

PC_02/UART0_TX/TRACE_D03/SPI0_RDY

RS-232

BOOT MODE SWITCH (SW1)

00
Bootmode (1:0)

01Default

10
11

No Boot
SPI Master Boot (internal SPI2)

UART Boot (UART0)
SPI Slave Boot (SPI0)
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U16

PI3A125
SC70_5

2 4

1OE

BA

GND3

R68 0
0402

C67
0.01UF
0402

R69
10K
0402

5V

C78
10UF
0805

C79
0.1UF
0402

5V

C68
0.1UF
0402

J3

IDC5X2_SMT_F

9

7

5

3

1

10

8

6

4

2

GND3

C69

0402
0.01UF

GND3

U26

ADM3053
SOIC127P1032X265-20N

20
16
13
11

14

18

8

10
9
7
3
1

6

15
17

19

12

4

5TXD

RXD

VISOOUT

VISOIN

CANH
CANL

VIO

GND1_0
GND1_1
GND1_2
GND1_3
GND1_4

VCC

RS

VREF

GND2_0
GND2_1
GND2_2
GND2_3

R70
60.4
0603

C70

0603
4700PF

C71

0402
0.01UF

R71
10
0603

C72
0.1UF
0402

J8

CON039
RJ11

1

2

3

4

U24

TSSOP8
GTL2002

2

4

3

81

7

5

6D1

D2

DREF

GND GREF

S1

S2

SREF

5V

C73

0402
0.1UF

5V

C107
0.01UF
0402

0402
0.1UF
C74 C75

10UF
0805

3.3V

3.3V

R72
10
0603

R73

0402
10K

U15

PI3A125
SC70_5

2 4

1OE

BA

C76

0402
0.1UF

3.3V

C77

0402
0.1UF

R139

DNP

0
0402

3.3V

C105

0402
0.01UF

3.3V

R140
680
0402

5V

C106

0402
0.01UF

R141
680
0402

R142
200.0K
0402

5V

PB_15/CAN0_RX/SPT1_ATDV/UART1_RX/SMC0_A03/TM0_ACI4

TWI0_SDA

TWI0_SCL

PC_00/CAN0_TX/SPT1_BTDV/UART1_TX/SMC0_A04

CAN0_VREF

CAN0_CANL

CAN0_VISO

CAN0_VISO

CAN0_VISOCAN0_VISO

CAN0_EN

CAN0_RX

CAN0_TX

CAN0_CANH

TWI0_SDA_DISPLAY

TWI0_SDA_DISPLAY

TWI0_SCL_DISPLAY TWI0_SCL_DISPLAY

Place between pins 6 and 7

20 X 2 Character Display

Place between pins 8 and 9 Place between pins 19 and 20Place between pins 11 and 12

CAN0



J7

SAMTEC_QSH-090-F-D-A

1
3
5
7
9

11
13
15
17
19
21
23
25
27
29
31
33
35
37
39
41
43
45
47
49
51
53
55
57
59

2
4
6
8
10
12
14
16
18
20
22
24
26
28
30
32
34
36
38
40
42
44
46
48
50
52
54
56
58
60

61
63
65
67
69
71
73
75
77
79
81
83
85
87
89
91
93
95
97
99

101
103
105
107
109
111
113
115
117
119

62
64
66
68
70
72
74
76
78
80
82
84
86
88
90
92
94
96
98
100
102
104
106
108
110
112
114
116
118
120

121
123
125
127
129
131
133
135
137
139
141
143
145
147
149
151
153
155
157
159
161
163
165
167
169
171
173
175
177
179

122
124
126
128
130
132
134
136
138
140
142
144
146
148
150
152
154
156
158
160
162
164
166
168
170
172
174
176
178
180

181
182
183
184

185
186
187
188

189
190
191
192

19
1

19
0

19
2

18
9

18
7

18
6

18
5

18
8

18
4

18
3

18
2

18
1

PWM

SINC

CNT

TWI

SPORT

GPIO

POWER

RESERVED

SPI

TMR

SYS

1.0
8 10
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A B C
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4

3
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C

Title

Size Board No.

Date Sheet of

DEVICES
ANALOG

Rev

3.3V5V

J2

SAMTEC_QSH-090-F-D-A

1
3
5
7
9

11
13
15
17
19
21
23
25
27
29
31
33
35
37
39
41
43
45
47
49
51
53
55
57
59

2
4
6
8
10
12
14
16
18
20
22
24
26
28
30
32
34
36
38
40
42
44
46
48
50
52
54
56
58
60

61
63
65
67
69
71
73
75
77
79
81
83
85
87
89
91
93
95
97
99

101
103
105
107
109
111
113
115
117
119

62
64
66
68
70
72
74
76
78
80
82
84
86
88
90
92
94
96
98
100
102
104
106
108
110
112
114
116
118
120

121
123
125
127
129
131
133
135
137
139
141
143
145
147
149
151
153
155
157
159
161
163
165
167
169
171
173
175
177
179

122
124
126
128
130
132
134
136
138
140
142
144
146
148
150
152
154
156
158
160
162
164
166
168
170
172
174
176
178
180

181
182
183
184

185
186
187
188

189
190
191
192

19
1

19
0

19
2

18
9

18
7

18
6

18
5

18
8

18
4

18
3

18
2

18
1

ADDRESS

DATA

CONTROL

UART

TWI

SPI

GPIO

RESERVED

POWER

SYS

5V3.3V
3.3V 5V 5V 3.3V

R143

0402
10K

R144

0402
10K

R145

0402
10K

R146
10K
0402

PB_08/PWM2_BH/TM0_TMR1/UART1_RX/SMC0_ARDY/TM0_ACI2

PB_08/PWM2_BH/TM0_TMR1/UART1_RX/SMC0_ARDY/TM0_ACI2

PB_08/PWM2_BH/TM0_TMR1/UART1_RX/SMC0_ARDY/TM0_ACI2

PB_08/PWM2_BH/TM0_TMR1/UART1_RX/SMC0_ARDY/TM0_ACI2

PB_08/PWM2_BH/TM0_TMR1/UART1_RX/SMC0_ARDY/TM0_ACI2

PB_08/PWM2_BH/TM0_TMR1/UART1_RX/SMC0_ARDY/TM0_ACI2

PB_09/PWM2_BL/TM0_TMR2/UART1_TX/SMC0_ARE

PB_09/PWM2_BL/TM0_TMR2/UART1_TX/SMC0_ARE

PB_09/PWM2_BL/TM0_TMR2/UART1_TX/SMC0_ARE

PB_09/PWM2_BL/TM0_TMR2/UART1_TX/SMC0_ARE

PB_09/PWM2_BL/TM0_TMR2/UART1_TX/SMC0_ARE

PC_01/UART0_RX/SMC0_A05/TM0_ACI5

PC_01/UART0_RX/SMC0_A05/TM0_ACI5

PB_04/PWM2_SYNC/UART0_RTS/SPT0_ATDV/SMC0_D12/CNT1_UD

PB_04/PWM2_SYNC/UART0_RTS/SPT0_ATDV/SMC0_D12/CNT1_UD

PB_04/PWM2_SYNC/UART0_RTS/SPT0_ATDV/SMC0_D12/CNT1_UD

PB_04/PWM2_SYNC/UART0_RTS/SPT0_ATDV/SMC0_D12/CNT1_UD

PB_05/PWM2_TRIP0/UART0_CTS/TM0_TMR7/SMC0_D13/CNT1_DG

PB_05/PWM2_TRIP0/UART0_CTS/TM0_TMR7/SMC0_D13/CNT1_DG

PB_05/PWM2_TRIP0/UART0_CTS/TM0_TMR7/SMC0_D13/CNT1_DG

PB_05/PWM2_TRIP0/UART0_CTS/TM0_TMR7/SMC0_D13/CNT1_DG

PB_05/PWM2_TRIP0/UART0_CTS/TM0_TMR7/SMC0_D13/CNT1_DG

PC_03/SPI0_CLK/PWM2_CH

PC_03/SPI0_CLK/PWM2_CH

PC_04/SPI0_MISO/PWM2_CL

PC_04/SPI0_MISO/PWM2_CL

PC_05/SPI0_MOSI/PWM2_DH

PC_05/SPI0_MOSI/PWM2_DH

PC_06/SPI0_SEL1/PWM2_DL/SYS_DSWAKE0

PC_06/SPI0_SEL1/PWM2_DL/SYS_DSWAKE0

PC_06/SPI0_SEL1/PWM2_DL/SYS_DSWAKE0

SYS_HWRST

SYS_HWRST
TWI0_SDA

TWI0_SDA

TWI0_SCL

TWI0_SCL

SYS_CLKOUT

SYS_NMI

SYS_NMI

PA_07/PWM0_CL/SMC0_AMS2/SPT1_BD1

PA_07/PWM0_CL/SMC0_AMS2/SPT1_BD1

PA_07/PWM0_CL/SMC0_AMS2/SPT1_BD1

PA_08/PWM1_CH/SMC0_D00/TM0_ACLK5
PA_08/PWM1_CH/SMC0_D00/TM0_ACLK5

PA_09/PWM1_CL/SMC0_D01/TM0_ACLK4
PA_09/PWM1_CL/SMC0_D01/TM0_ACLK4

PA_11/PWM1_TRIP0/UART1_CTS/SMC0_D03/TM0_ACLK2

PA_11/PWM1_TRIP0/UART1_CTS/SMC0_D03/TM0_ACLK2

PA_11/PWM1_TRIP0/UART1_CTS/SMC0_D03/TM0_ACLK2

PA_12/PWM1_AH/TM0_TMR4/SMC0_D04

PA_12/PWM1_AH/TM0_TMR4/SMC0_D04

PA_13/PWM1_AL/TM0_TMR5/SMC0_D05

PA_13/PWM1_AL/TM0_TMR5/SMC0_D05

PA_14/PWM1_BH/TM0_TMR6/SMC0_D06

PA_14/PWM1_BH/TM0_TMR6/SMC0_D06

PA_15/PWM1_BL/TM0_TMR3/SMC0_D07

PA_15/PWM1_BL/TM0_TMR3/SMC0_D07

PB_13/SINC0_D2/CNT0_OUTA/SPI0_SEL2/SMC0_A01/TM0_ACLK0/SYS_DSWAKE3
PB_13/SINC0_D2/CNT0_OUTA/SPI0_SEL2/SMC0_A01/TM0_ACLK0/SYS_DSWAKE3

PB_13/SINC0_D2/CNT0_OUTA/SPI0_SEL2/SMC0_A01/TM0_ACLK0/SYS_DSWAKE3

PB_13/SINC0_D2/CNT0_OUTA/SPI0_SEL2/SMC0_A01/TM0_ACLK0/SYS_DSWAKE3

PB_13/SINC0_D2/CNT0_OUTA/SPI0_SEL2/SMC0_A01/TM0_ACLK0/SYS_DSWAKE3

PB_14/SINC0_D3/CNT0_OUTB/SPI0_SEL3/SMC0_A02/SPI0_SS/SYS_DSWAKE2
PB_14/SINC0_D3/CNT0_OUTB/SPI0_SEL3/SMC0_A02/SPI0_SS/SYS_DSWAKE2

PB_14/SINC0_D3/CNT0_OUTB/SPI0_SEL3/SMC0_A02/SPI0_SS/SYS_DSWAKE2
PB_14/SINC0_D3/CNT0_OUTB/SPI0_SEL3/SMC0_A02/SPI0_SS/SYS_DSWAKE2

PB_14/SINC0_D3/CNT0_OUTB/SPI0_SEL3/SMC0_A02/SPI0_SS/SYS_DSWAKE2

PB_14/SINC0_D3/CNT0_OUTB/SPI0_SEL3/SMC0_A02/SPI0_SS/SYS_DSWAKE2
PB_14/SINC0_D3/CNT0_OUTB/SPI0_SEL3/SMC0_A02/SPI0_SS/SYS_DSWAKE2

PA_06/PWM0_CH/SPT1_BD0

PA_06/PWM0_CH/SPT1_BD0

PA_05/PWM0_BL/SPT1_BFS

PA_05/PWM0_BL/SPT1_BFS

PA_04/PWM0_BH/SPT1_BCLK

PA_04/PWM0_BH/SPT1_BCLK

PA_03/PWM0_AL/SPT1_AD1

PA_03/PWM0_AL/SPT1_AD1

PA_02/PWM0_AH/SPT1_AD0

PA_02/PWM0_AH/SPT1_AD0

PA_01/PWM0_TRIP0/SPT1_AFS

PA_01/PWM0_TRIP0/SPT1_AFS

PA_01/PWM0_TRIP0/SPT1_AFS

PA_00/PWM0_SYNC/SPT1_ACLK

PA_00/PWM0_SYNC/SPT1_ACLK

5V_INPUT 5V_INPUT

SYS_RESOUT SYS_FAULTSYS_FAULT

PA_10/PWM1_SYNC/SMC0_D02/TM0_ACLK3

PA_10/PWM1_SYNC/SMC0_D02/TM0_ACLK3

PC_07/SINC0_CLK1/UART2_TX/UART1_RTS/SYS_DSWAKE1

PC_07/SINC0_CLK1/UART2_TX/UART1_RTS/SYS_DSWAKE1

PC_07/SINC0_CLK1/UART2_TX/UART1_RTS/SYS_DSWAKE1

PB_06/PWM2_AH/TM0_CLK/SMC0_D14

PB_06/PWM2_AH/TM0_CLK/SMC0_D14

PB_06/PWM2_AH/TM0_CLK/SMC0_D14

PB_06/PWM2_AH/TM0_CLK/SMC0_D14

PB_06/PWM2_AH/TM0_CLK/SMC0_D14

PB_07/PWM2_AL/TM0_TMR0/SMC0_D15

PB_07/PWM2_AL/TM0_TMR0/SMC0_D15

PB_07/PWM2_AL/TM0_TMR0/SMC0_D15

PB_07/PWM2_AL/TM0_TMR0/SMC0_D15

PB_07/PWM2_AL/TM0_TMR0/SMC0_D15

PB_12/SINC0_D1/UART2_RX/SMC0_AOE/TM0_ACI3

PB_12/SINC0_D1/UART2_RX/SMC0_AOE/TM0_ACI3

PB_12/SINC0_D1/UART2_RX/SMC0_AOE/TM0_ACI3

PB_00/PWM0_DH/TRACE_CLK/SPT0_ACLK/SMC0_D08/CNT0_ZM_EXP

PB_00/PWM0_DH/TRACE_CLK/SPT0_ACLK/SMC0_D08/CNT0_ZM_EXP

PB_00/PWM0_DH/TRACE_CLK/SPT0_ACLK/SMC0_D08/CNT0_ZM_EXP

PB_15/CAN0_RX/SPT1_ATDV/UART1_RX/SMC0_A03/TM0_ACI4_EXP

PB_15/CAN0_RX/SPT1_ATDV/UART1_RX/SMC0_A03/TM0_ACI4_EXP

PB_15/CAN0_RX/SPT1_ATDV/UART1_RX/SMC0_A03/TM0_ACI4_EXP

PC_00/CAN0_TX/SPT1_BTDV/UART1_TX/SMC0_A04_EXP

PC_00/CAN0_TX/SPT1_BTDV/UART1_TX/SMC0_A04_EXP

PC_00/CAN0_TX/SPT1_BTDV/UART1_TX/SMC0_A04_EXP

PB_01/PWM0_DL/TRACE_D00/SPT0_AFS/SMC0_D09/CNT0_UD_EXP

PB_01/PWM0_DL/TRACE_D00/SPT0_AFS/SMC0_D09/CNT0_UD_EXP

PB_01/PWM0_DL/TRACE_D00/SPT0_AFS/SMC0_D09/CNT0_UD_EXP

PB_02/PWM1_DH/TRACE_D01/SPT0_AD0/SMC0_D10/CNT0_DG_EXP

PB_02/PWM1_DH/TRACE_D01/SPT0_AD0/SMC0_D10/CNT0_DG_EXP

PB_02/PWM1_DH/TRACE_D01/SPT0_AD0/SMC0_D10/CNT0_DG_EXP

PB_03/PWM1_DL/TRACE_D02/SPT0_AD1/SMC0_D11/CNT1_ZM_EXP

PB_03/PWM1_DL/TRACE_D02/SPT0_AD1/SMC0_D11/CNT1_ZM_EXP

PB_03/PWM1_DL/TRACE_D02/SPT0_AD1/SMC0_D11/CNT1_ZM_EXP

PC_02/UART0_TX/TRACE_D03/SPI0_RDY_EXP

PC_02/UART0_TX/TRACE_D03/SPI0_RDY_EXP

PC_02/UART0_TX/TRACE_D03/SPI0_RDY_EXP

PB_11/SINC0_D0/SPI0_D3/CAN1_TX/SMC0_AMS0/TM0_ACLK1_J7

PB_11/SINC0_D0/SPI0_D3/CAN1_TX/SMC0_AMS0/TM0_ACLK1_J7

PB_10/SINC0_CLK0/SPI0_D2/CAN1_RX/SMC0_AWE/TM0_ACI1_J7

PB_10/SINC0_CLK0/SPI0_D2/CAN1_RX/SMC0_AWE/TM0_ACI1_J7

PC_03/SPI0_CLK/PWM2_CH_J2
PC_05/SPI0_MOSI/PWM2_DH_J2

PC_04/SPI0_MISO/PWM2_CL_J2

PB_10/SINC0_CLK0/SPI0_D2/CAN1_RX/SMC0_AWE/TM0_ACI1_J2

PB_10/SINC0_CLK0/SPI0_D2/CAN1_RX/SMC0_AWE/TM0_ACI1_J2

PB_11/SINC0_D0/SPI0_D3/CAN1_TX/SMC0_AMS0/TM0_ACLK1_J2

PB_11/SINC0_D0/SPI0_D3/CAN1_TX/SMC0_AMS0/TM0_ACLK1_J2
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Title

Size Board No.

Date Sheet of

DEVICES
ANALOG

Rev

R76

0402
10K

R82

0402
10K

R83

0402
10K

U28

ADM708SARZ
SOIC8

7

5

1 8

4PFI

RESETMR

PFO

RESET

SW2
MOMENTARY
SWT024

3.3V

R89

0402
10K

3.3V

R90

0402
10K R91

0402
330.0

3.3V

C80
0.01UF
0402

3.3V

C81

0402
0.01UF

C82
0.01UF
0402

U29

SN74LVC1G08
SOT23-5

4
2

1

U30

SN74LVC1G08
SOT23-5

4
2

1

LED3
YELLOW
LED_0603

U5

IDT74FCT3244APY
SSOP20

19

1

3

5

7

9

17

15

13

11

12

14

16

18

8

6

4

2
1A1

1A2

1A3

1A4

1Y1

1Y2

1Y3

1Y4

2A1

2A2

2A3

2A4

2Y1

2Y2

2Y3

2Y4

OE1

OE2

3.3V

R75
10K
0402

C83
0.01UF
0402

3.3V

LED5
GREEN
LED_0603

R77
330.0
0402

R78
330.0
0402

R79
330.0
0402

R80
330.0
0402

R81
10K
0402

R84
10K
0402

R85
10K
0402

U17

PI3A125
SC70_5

2 4

1OE

BA

R86
10K
0402

R87
10K
0402

U18

PI3A125
SC70_5

2 4

1OE

BA

R88
10K
0402

U19

SC70_5
PI3A125

2 4

1OE

BA

C84
0.01UF
0402

C85
0.01UF
0402

C86
0.01UF
0402

3.3V

C87

0402
0.01UF

3.3V

C88

0402
0.01UF

U3

74LVC14A
SOIC14

1011

U3

74LVC14A
SOIC14

43

U3

74LVC14A
SOIC14

65

U3

74LVC14A
SOIC14

89

3.3V

SW3
MOMENTARY
SWT024

R93

0402
10K

SW4
MOMENTARY
SWT024

R94
33
0402

R95
100
0402

C89
0.01UF
0402

R96
100
0402

R97

0402
10K

R98

0402
10K

C90
1UF
0402

C91
1UF
0402

3.3V

3.3V

R99

0402
10K

R101
33
0402

U20

PI3A125
SC70_5

24

1OE

B A

U21

PI3A125
SC70_5

24

1OE

B A

LED4
RED
LED_0603

LED2
YELLOW
LED_0603

LED1
YELLOW
LED_0603

PB_04/PWM2_SYNC/UART0_RTS/SPT0_ATDV/SMC0_D12/CNT1_UD

PB_05/PWM2_TRIP0/UART0_CTS/TM0_TMR7/SMC0_D13/CNT1_DG

PB_15/CAN0_RX/SPT1_ATDV/UART1_RX/SMC0_A03/TM0_ACI4

JTAG_BOARD_RESET

SYS_HWRST

CTS

LED3_GPIO3_EN

LED2_GPIO2_EN

LED1_GPIO1_EN

PUSHBUTTON1_EN

PUSHBUTTON2_EN

PB_06/PWM2_AH/TM0_CLK/SMC0_D14

PB_07/PWM2_AL/TM0_TMR0/SMC0_D15

"RESET"

"RESET"

POWER

LABEL "PB2"

LABEL "PB1"



SJ7

DEFAULT=INSTALLED
JUMPER
SHORTING

R103

DNP

0
0402

VR2

ADP2118ACPZ
QFN65P400X400X80-17N
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9

11

87

2

3

17

4

16

15

5

13

1

6

10
14VIN

SW1

P
G

N
D

0

SYNC/MODE

PVIN0

G
N

DEN

PGOOD

FB

E
P

A
D

TRK

FREQ

P
G

N
D

1
P

G
N

D
2

SW0

SW2
PVIN1
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DEVICES
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Rev

R112
10K
0402

R113
45.3K
0402

P6

IDC2X1

1 2

5V

P7

CON045

2

3

1

POWER

SHGND

SHGND

F1
3A
FUS004

D6
MBRS540T3G

SMC

FER3
190
FER002

2

3

1

4

C92
1000PF
1206

D2
GSOT05

SOT23-3

FER1
600
1206

C93
10UF
1210

FER2
600
1206

C94
1000PF
1206

GP1
LOOP_2838

JP4

IDC3X1

3

2

1

SJ6

DEFAULT=1&2
JUMPER
SHORTING

5V

TP19TP20TP21TP22TP23

R110
0
0402
DNP

R104
10K
0402

R105
0
0402

L2

IND003
1.5UH

R111
0
0402

C95
0.1UF
0402

R106

0402
0

R107

0603
10

5V

C96

1210
22UF

R102
0.05
1206

3.3V

TP24

TP9

D3
GSOT03

SOT23-3

R108
0
0402
DNP

C97

1210
22UF

C98

1210
22UF SJ5

DEFAULT=INSTALLED
JUMPER
SHORTING

P5

IDC2X1

1 2

R109
0.05
1206

D7
MBRS540T3G

SMC

C99
0.1UF
0402

5V_INPUT

VDD_EXT

WALL_POWER

WALL_POWER

"5V"

GND Test Points are scattered on PCB for Test Measurement Purposes.

LABEL "GND" ON ALL TPs

3.3V @ 1.5A

Remove P6 when measuring VDD_EXT

"VDD_EXT"
Remove P5 when measuring 3.3V

"3.3V"
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I INDEX

A
ADSP-CM403F processor, x
analog connector (J9), 2-21
architecture, of this EZ-KIT Lite, 2-2
asynch or memory connector (J2), 2-20

B
bill of materials, A-1
board schematic (ADSP-CM403F), B-1
bus switch, 2-5

example, 2-6

C
CAN0 connector (J8), 2-21
character display connector (J3), 2-20
configuration, of this EZ-KIT Lite, 1-3
connectors, 2-19

diagram of locations, 2-19
J1 (DCE UART), 2-20
J2 (asynch or memory), 2-20
J3 (character display), 2-20
J7 (PWM), 2-21
J8 (CAN0), 2-21
J9 (analog), 2-21
P1 (JTAG/SWD/SWV), 2-21
P2 (TRACE and JTAG/SWD/SWV), 

2-22
P3 (VREF buffered), 2-22
P7 (power), 2-22

contents, of this EZ-KIT Lite package, 1-2

D
DCE UART connector (J1), 2-20
debug interface, 1-10
default configuration, of this EZ-KIT Lite, 

1-3
default jumper and switch settings, 1-4
default processor interface availability, 2-7
design reference information, 1-13

E
EngineerZone, xviii
example programs, 1-13
expansion interface, 1-11

F
FET switches, 2-4

example, 2-4

G
general-purpose I/O pins (GPIO), 2-18

I
installation, of this EZ-KIT Lite, 1-4, 1-5

J
JTAG/SWD/SWV connector (P1), 2-21
jumpers

diagram of locations, 2-14
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I-2 ADSP-CM403F EZ-KIT Lite Evaluation System Manual

L
LEDs, 2-17

diagram of locations, 2-17
LED1-3 (GPIO), 2-18
LED4 (reset), 2-18
LED5 (power), 2-18
LED6 (SYS_FAULT), 2-18

M
mechanical switch, 2-5, 2-7

N
notation conventions, xviii

P
package contents, 1-2
power

architecture, 1-12
LED (LED5), 2-18
measurements, 1-12

power connector (P7), 2-22
power-on-self test (POST), 1-11
product overview, x
programming SoftConfig switches, 2-8
push buttons and switches, 2-12
PWM connector (J7), 2-21

R
reset LED (LED4), 2-18

S
schematic, of ADSP-CM403F EZ-KIT 

Lite, B-1
serial liquid crystal display module 

interface, 1-10
SoftConfig

on the EZ-KIT Lite, 2-7
overview, 2-3
programming switches, 2-8

supported tools, xvii
switches

programming SoftConfig, 2-8
switches, diagram of locations, 2-12
SYS_FAULT LED (LED6), 2-18
system architecture, of this EZ-KIT Lite, 
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Мы молодая и активно развивающаяся компания в области  поставок 

электронных компонентов. Мы поставляем  электронные  компоненты  

отечественного и импортного производства напрямую от производителей и с 

крупнейших складов мира. 

Благодаря сотрудничеству с мировыми поставщиками мы осуществляем 

комплексные и плановые поставки   широчайшего   спектра электронных 

компонентов. 

Собственная  эффективная  логистика и склад в обеспечивает надежную 

поставку продукции в точно указанные сроки по всей России. 

Мы осуществляем  техническую поддержку нашим клиентам и 

предпродажную проверку качества продукции. На  все поставляемые продукты 

мы предоставляем  гарантию . 

Осуществляем поставки продукции под контролем ВП МО РФ на 

предприятия военно-промышленного комплекса  России , а также работаем в 

рамках 275 ФЗ с открытием отдельных счетов в уполномоченном банке. Система 

менеджмента качества компании соответствует требованиям ГОСТ ISO 9001.  

Минимальные сроки поставки, гибкие цены, неограниченный 

ассортимент  и индивидуальный подход к клиентам являются основой для 

выстраивания долгосрочного и эффективного сотрудничества с предприятиями 

радиоэлектронной промышленности, предприятиями  ВПК и научно-

исследовательскими  институтами России. 

С нами вы становитесь  еще успешнее! 

 

 

 

 

 

Наши контакты: 

Телефон: +7 812 627 14 35 

Электронная почта: sales@st-electron.ru 

Адрес: 198099, Санкт-Петербург,  

Промышленная ул, дом № 19, литера Н,  

помещение 100-Н Офис 331 
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